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Important User Information
Read this document and the documents listed in the additional resources section about installation, configuration, and operation of this equipment before you install, 
configure, operate, or maintain this product. Users are required to familiarize themselves with installation and wiring instructions in addition to requirements of all 
applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to be carried out by suitably trained 
personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements associated with any particular 
installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

WARNING:   Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal 

injury or death, property damage, or economic loss. 

ATTENTION:   Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. 

Attentions help you identify a hazard, avoid a hazard, and recognize the consequence. 

IMPORTANT:   Identifies information that is critical for successful application and understanding of the product. 

These labels may also be on or inside the equipment to provide specific precautions.

SHOCK HAZARD:   Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. 

BURN HAZARD:   Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous 

temperatures. 

ARC FLASH HAZARD:   Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash 

will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for 

Personal Protective Equipment (PPE). 

The following icon may appear in the text of this document.

Tip:   Identifies information that is useful and can help to make a process easier to do or easier to understand. 

Rockwell Automation  recognizes that some of the terms that are currently used in our industry and in this publication are not in alignment with the movement toward 
inclusive language in technology. We are proactively collaborating with industry peers to find alternatives to such terms and making changes to our products and content. 
Please excuse the use of such terms in our content while we implement these changes.
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Chapter 1

Introduction
Studio 5000 Architect®   is a tool for creating the basic I/O and communication configurations for automation 

systems. Use the visual editing system in Studio 5000 Architect  to rapidly assemble and connect control hardware, 

I/O modules, and visualization devices.

Use Studio 5000 Architect  to create and import  ControlLogix®  ,  CompactLogix™  ,  Compact I/O™  , FLEX™  I/O,  FLEX 

Ex™  ,  POINT I/O™  ,  GuardLogix®  ,  Kinetix®  , and  PowerFlex®   controllers, modules, and drives. Edit chassis positions, 

firmware settings, I/O aliases, and network configurations in Studio 5000 Architect. Launch  Studio 5000®   Logix 

Designer  to edit program logic and advanced configurations.

Studio 5000 Architect  can also create and import  FactoryTalk®   View Site Edition and FactoryTalk View ME 

visualization projects, including  PanelView™   Plus graphic terminals,  MobileView™   graphic terminals, FactoryTalk® 

Linx™  and FactoryTalk Alarms and Events  servers. Edit screen resolution, areas, shortcuts, and network configuration 

in Studio 5000 Architect. Launch  FactoryTalk®   View Studio to edit application screens and program logic.

Connect components using  ControlNet™   network trunks or  EtherNet/IP™   networks using generic or Stratix® 

switches. Once connected, configure ownership relationships, producer/consumer relationships, and shortcuts so 

that devices share tags across the network.

Studio 5000 Architect  can import components from  EPLAN®   or Integrated Architecture®  Builder  and export 

components to EPLAN. Custom components such as Add-On Instructions (AOI), User-Defined Types (UDT), Displays, 

Global Objects, and Images can be exchanged between Logix Designer, FactoryTalk View Studio, and the Rockwell 

Automation Process Library.

Import automation system data into Studio 5000 Architect  and export out of Studio 5000 Architect  using .rdf, .aml, 

and .xml files.

Hardware Diagram
How do I open Hardware Diagram?

• In Project Explorer, expand the Devices  folder, then select a hardware diagram.

Use Hardware Diagram  to view and organize components that are added to a Studio 5000 Architect  project. If 

multiple hardware diagrams are open simultaneously, switch between them using the tabs at the top of Hardware 

Diagram.

A large hardware diagram can exceed the display area in Hardware Diagram. Use the scroll bars or Diagram 

Overview  to navigate to a section of a hardware diagram.

Project Explorer
How do I open Project Explorer?

• From the View  menu, select Project Explorer.
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Chapter 1        Introduction

Use Project Explorer  to view or edit the contents of a Studio 5000 Architect  project.

Item Name Description

FactoryTalk View  applications An alphabetical list of FactoryTalk 

View  applications associated with 

this Studio 5000 Architect  project. If 

Arrange Projects by Hardware Diagram 

is enabled, projects are grouped by 

hardware diagram (shown).

Logix Designer  projects An alphabetical list of Logix Designer 

projects associated with this Studio 5000 

Architect  project, grouped by hardware 

diagram.

Devices An alphabetical list of devices in this 

Studio 5000 Architect  project, grouped by 

hardware diagram.
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Chapter 1        Introduction

Item Name Description

Components An alphabetical list of hardware 

components added to a hardware 

diagram, such as chassis, controllers, 

modules, computers, PanelView Plus  and 

MobileView  terminals.

Toolbox
How do I open Toolbox?

• From the View  menu, select Toolbox.

Use Toolbox  to view default hardware components or add, remove, and manage custom libraries. Drag components 

from the Toolbox  to a Hardware Diagram  to add components to a project.
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Chapter 1        Introduction

Components shown in gray are either unsupported in Studio 5000 Architect  or require a version of Logix Designer 

that is not installed on the system.

The Toolbox  sections are:
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Item Name Description

Filter  on page 87 Enter a catalog number or name to show 

matching Logix Designer, FactoryTalk 

View Studio, and library components.

Product Catalog A list of Logix Designer  and FactoryTalk 

View Studio  components that can be 

added to a hardware diagram.

Libraries A list of libraries containing components 

that can be added to a hardware diagram 

or a Logix Designer  or FactoryTalk View 

Studio  project.

Manage components
A Studio 5000 Architect  project contains one or more components. Each component represents a hardware device, 

software project, visualization server, or document. Components appear in Hardware Diagram  and Project Explorer.

Add components from a library or import from a file or online controller. Once part of a project, connect components 

to networks and configure relationships to share tags and control an automation system.

Components that are no longer in use can be removed from a project.
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Chapter 2

Install and activate the software
Install  on page 15 and activate  on page 15 Studio 5000 Architect  on a computer that meets the system 

requirements to begin designing automation systems.

System requirements
To run Studio 5000 Architect, the host computer must meet the hardware, software, and firmware requirements. For 

the latest compatibility information, refer to the Product Compatibility and Download Center.

Hardware requirements

Studio 5000 Architect  requires the following hardware:

• Intel®   Core 2 Duo, 2.8 GHz processor

• 1 GB of memory

• 16 GB free disk space

• 1024x768, true color graphics device

Software requirements

Studio 5000 Architect  has been tested on the following operating systems:

• Windows Server®   2022

• Windows  Server 2019

• Windows®   11 (v21H2 and v22H2)

• Windows  10 (v21H2 and v22H2)

• Windows  10 IoT Enterprise 2021 Long-Term Servicing Channel (LTSC)

• Windows  10 IoT Enterprise 2019 Long-Term Servicing Channel (LTSC)

Studio 5000 Architect  is compatible with these Rockwell Automation  products:

• FactoryTalk®  Services Platform  version 6.40.00

• FactoryTalk®  Activation Manager  version 5.01.00

• RSLogix 5000®   version 20.00.00

• Logix Designer  application version 21.03.01, 23.00.00, and 24.00 through 36.00.00

• FactoryTalk View  version 8.10.00 through 14.00.00

• FactoryTalk®  Alarms and Events  version 6.40.00

• RSLinx®  Classic  version 4.40.00

• FactoryTalk®  Linx™  version 6.40.00

Firmware requirements

Studio 5000 Architect  does not have any firmware requirements. Hardware and software products used in Studio 

5000 Architect  projects might place limits on firmware revisions. Read the release notes for each product in the 

FactoryTalk  system to determine firmware limitations.
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Chapter 2        Install and activate the software

Install the software
Install Studio 5000 Architect  on a computer that meets the system requirements  on page 14 to begin designing 

automation systems.

To install Studio 5000 Architect

1. Log on to the computer as a user with administrative privileges.

2. Run Setup.exe to start the Studio 5000 Architect  installation program.

3. In Setup, select an installation option:

◦ Install now:  Installs Studio 5000 Architect  components using the recommended settings.

◦ Customize:  Select which Studio 5000 Architect  components to install, then select Install.

4. In End User License Agreements, read the license agreements, then select an option:

◦ Accept all:  Accept terms of all license agreements and continue installation.

◦ Decline:  Decline terms of all license agreements and cancel installation.

5. When installation is complete, select Finish.

Activate the software
Studio 5000 Architect  is copy protected and must be activated using FactoryTalk Activation Manager. When starting 

Studio 5000 Architect, FactoryTalk Activation Manager  verifies its activation is valid. If Studio 5000 Architect  was 

not yet activated, use the software for a seven-day grace period with full functionality. If the grace period ends and 

Studio 5000 Architect  was not successfully activated, Studio 5000 Architect  does not start and an error is logged to 

FactoryTalk®  Diagnostics.

If unable to complete the activation process from the computer where Studio 5000 Architect  is installed, obtain an 

activation from the Rockwell Automation Activation web site.
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Chapter 3

Manage projects
Use the  Studio 5000®   Launcher  to create or open a Studio 5000 Architect  project. After designing an automation 

system, save and close the project.

About projects
Studio 5000 Architect  projects are saved as a project file (.ADL) and a project folder containing related files. Studio 

5000 Architect  projects are composed of Hardware Diagrams  and Components.

Hardware Diagrams

A hardware diagram is a collection of hardware, software, and reference components that represent an automation 

system. Creating a new Studio 5000 Architect  project adds a hardware diagram automatically.

Hardware diagrams are displayed in Hardware Diagram  and under the Projects  and Devices  folders in Project 

Explorer. As hardware diagrams are added, removed, and renamed, the corresponding folders in Project Explorer 

are added, removed, and renamed.

Components

Components are added to a hardware diagram to represent part of an automation system.

There are three types of components: hardware components, software components, and reference components.

Hardware components represent physical hardware, such as controllers, modules, computers, visualization devices, 

and networks. Hardware components are displayed in Hardware Diagram  and in Project Explorer  under Devices. 

Hardware components are stored as part of the Studio 5000 Architect  project file.

Software components represent Logix Designer  and FactoryTalk View  applications that run on hardware components. 

Software components are only shown in the Project Explorer  tree under the Projects  folder. Software components 

are stored as Logix Designer  (.ACD) files and FactoryTalk View Studio  project folders under the Studio 5000 Architect 

project folder. Edit the project files and folders using Logix Designer  and FactoryTalk View Studio.

Changes made to software components in Studio 5000 Architect  projects do not automatically show in Logix Designer 

projects or FactoryTalk View  applications. Similarly, changes made to Logix Designer  projects or FactoryTalk View 

applications do not automatically show in Studio 5000 Architect  projects. To push changes from Studio 5000 

Architect  projects, commit the Studio 5000 Architect  project. To pull changes from Logix Designer  projects or 

FactoryTalk View  applications, update the Studio 5000 Architect  project.

Graphics, files, text boxes, shapes, and links are reference components that describe other components. Reference 

components are only shown in Hardware Diagram. Reference components are stored as part of the Studio 5000 

Architect  project file.

Create a project
To design a new automation system, create a Studio 5000 Architect  project. Studio 5000 Architect  projects are stored 

in the logged in user's directory at Documents\Studio 5000\Projects by default.
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To create a new project

1. Open Studio 5000.

2. Select New Project.

3. In the Project Types  column, select Architect.

4. Select an Architect  project template.

◦ Blank Project  creates a new project with no components.

◦ Distributed Architecture - Connected Enterprise  creates a new project with one engineering 

workstation, one operator workstation, one FactoryTalk View  Site Edition server, and five FactoryTalk 

View  Machine Edition stations. The FactoryTalk View  server and stations control one 1756 ControlLogix 

controller and four 1769 CompactLogix  controllers.

◦ Distributed Architecture - Multiple Process Servers  creates a new project with one operator 

workstation and two Process Automation System Servers (PASS) servers. Each PASS server controls five 

1756 ControlLogix  controllers.

◦ Distributed Architecture - Single Process Server  creates a new project with one operator 

workstation and one Process Automation System Server. The PASS server controls five 1756 

ControlLogix  controllers.

◦ Process Skid with Logix Batch Sequence Manager  creates a new project with one PanelView Plus 7 

graphic terminal that controls three 1769 CompactLogix  controllers.

5. In Name, enter a name for the new project.

6. (optional) In Location, type or browse to a location to store the project file.

7. Select Finish.

Open a project
To edit an existing Studio 5000 Architect  project, open it using Studio 5000. Studio 5000 Architect  projects are 

stored in the current user's directory at Documents\Studio 5000\Projects by default. Each instance of Studio 5000 

Architect  can have a single open project.

If the Studio 5000 Architect  project contains Logix Designer  or FactoryTalk View  applications and those projects 

changed, Studio 5000 Architect  displays Project Update  to update the hardware diagram.

To open a project

1. Open Studio 5000.

2. Select Existing Project.

3. From the list of file types, select Architect (.adl).

4. Navigate to the folder that contains the Studio 5000 Architect  project file.

5. Select the project from the list.

6. Select Open.

Save a project
Saving a project records the locations, properties, relationships, and tags of all components in the Studio 5000 

Architect  project file. By default, Studio 5000 Architect  projects are stored in the directory of the logged in user at 

Documents\Studio 5000\Projects.

Saving a project does not commit changes to Logix Designer  projects or FactoryTalk View  applications.
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Chapter 3        Manage projects

To save a project

1. From the File  menu, select Save As.

2. (optional) In Save Project As, enter a name for the new project.

3. (optional) In Save Project As, select a location to store the project file.

4. Select Save.

Close a project
Each instance of Studio 5000 Architect  can have a single open project. To open a project in the same Studio 5000 

Architect  instance, first close the current project.

To close a project

• From the File  menu, select Close.

Project Update
How do I open Project Update?

• Project Update  only appears when opening a Studio 5000 Architect  project that contains Logix Designer  or 

FactoryTalk View  projects. If the Logix Designer  or FactoryTalk View  project has changed since the last time 

the Studio 5000 Architect  project was opened, Studio 5000 Architect  displays Project Update.

Use Project Update  to select which controllers and project files overwrite components in the Studio 5000 Architect 

project. The Selected controller validation results  table lists all the changes to be made to the Studio 5000 

Architect  project.
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Add hardware diagrams
A hardware diagram is a grid that contains components representing an automation system. A Studio 5000 Architect 

project can contain many hardware diagrams, which can be open simultaneously as tabs in Hardware Diagram. 

Components must be on the same hardware diagram to communicate with each other.

If adding or moving components past the right or bottom edge of a hardware diagram, Studio 5000 Architect 

automatically expands the hardware diagram to a new page. Page breaks appear as dashed gray lines and do not 

print. When closing and reopening a hardware diagram, Studio 5000 Architect  automatically shrinks the hardware 

diagram to the number of pages necessary to show the components in the hardware diagram.

Hardware diagrams are displayed in Hardware Diagram  and under the Projects  and Devices  folders in Project 

Explorer.

Optimize Network Layout
When manually configuring a hardware diagram, or adding or importing devices from a library or file, devices may 

appear in a random order and network cables may appear crossed. Optimize Network Layout  repositions the 

devices and refines the network layout.

When importing data files into Studio 5000 Architect, the hardware diagram is optimized upon import.

To Optimize Network Layout

• Right-click in the hardware diagram and select Optimize Network Layout.

Add a hardware diagram
Add a hardware diagram to group a new set of components within the same Studio 5000 Architect  project.

To add a hardware diagram

1. In Project Explorer, right-click on the Devices  folder, then select New Hardware Diagram.

2. (optional) In Enter New Hardware Diagram Name, type a name for the new hardware diagram.

3. Select OK. The new hardware diagram appears in the Hardware Diagram  and under the Project  and Devices 

folders in Project Explorer.

Open a hardware diagram
Open a hardware diagram to view or edit its components.

To open a hardware diagram

• In Project Explorer, expand the Project  or Devices  folders, then select the hardware diagram to open.

Navigate a hardware diagram
A large hardware diagram can exceed the display area in Hardware Diagram  on page 9. Use Diagram Overview  to 

quickly navigate to a section of a hardware diagram.
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To navigate a hardware diagram

1. (optional) If Diagram Overview  is not visible, select View > Diagram Overview.

2. In Diagram Overview, select to center Hardware Diagram  at the selected location.

Show or hide the grid
Snap to Grid  aligns components vertically or horizontally on a hardware diagram according to grid lines. Show grid 

displays the alignment grid in the hardware diagram, Hide grid  removes the grid lines from the hardware diagram 

display, so that only components are shown.

Components placed on the hardware diagram use the Snap to Grid  setting even when the grid is hidden.

To show or hide the grid

• Below Hardware Diagram, select Hide grid  or Show grid.

Enable or disable snap to grid
When Snap to Grid  is enabled, components dropped on the Hardware Diagram  pane automatically align horizontally 

and vertically to the grid lines, even if the grid lines are hidden. When Snap to Grid  is disabled, components are 

placed on the Hardware Diagram  pane where they are dropped.

To enable or disable Snap to Grid

• Below Hardware Diagram, select Snap to grid  or Turn off snap to grid.

Close a hardware diagram
Close a hardware diagram to hide a hardware diagram from view without closing the Studio 5000 Architect  project.

To close a hardware diagram

• At the top of Hardware Diagram, right-click the name of the hardware diagram, then select Close.

Remove a hardware diagram
Remove a hardware diagram to delete it and all associated hardware components and software projects from a 

Studio 5000 Architect  project. The remove operation cannot be undone.

To remove a hardware diagram

1. In Project Explorer, expand the Devices  folder, right-click on a hardware diagram, then select Delete.

2. In the confirmation prompt, select Yes.

Diagram Overview
How do I open Diagram Overview?

• From the View  menu, select Diagram Overview.

Use Diagram Overview  to quickly navigate large hardware diagrams. Diagram Overview  shows the full contents of 

the active hardware diagram, including all devices, networks, and images.
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The red rectangle in Diagram Overview  represents the current view in Hardware Diagram  on page 9. Clicking in 

Diagram Overview  centers both the red rectangle and Hardware Diagram  at the selected location.
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Add new components
A Studio 5000 Architect  project contains one or more components. Each component represents a hardware device, 

software project, visualization server, or document. Components appear in Hardware Diagram  and Project Explorer.

Add components to your project from the Toolbox, using the predefined components or an imported library. Once 

added, connect components to networks and configure relationships to share tags and control an automation system.

For a list of supported Logix Designer  controllers, see Studio 5000 Architect  Help.

Add 1756 ControlLogix hardware
Add a variety of 1756 ControlLogix  hardware, including chassis, controllers, and modules to a Studio 5000 Architect 

project. Chassis, controllers, and modules appear in Hardware Diagram  and Project Explorer.

Add a 1756 ControlLogix chassis
Automation systems driven by 1756 ControlLogix  controllers require one or more chassis to connect controllers and 

I/O modules.

To add a 1756 ControlLogix  chassis

1. In Toolbox, expand Product Catalog,  Programmable Control Systems, 1756 ControlLogix/GuardLogix 

Systems, and Chassis.

2. Drag a chassis from Toolbox  to Hardware Diagram.

3. (optional) In New Chassis Graphic, enter a unique name for the chassis.

4. Select OK. The chassis appears in Hardware Diagram  and Project Explorer.

Add a 1756-L6x or L7x controller
Automation systems driven by 1756-L6x or L7x ControlLogix  controllers require one or more controllers to manage 

inputs, outputs, and run applications.

Prerequisites

• Add a 1756 ControlLogix  chassis  on page 22

To add a 1756-L6x or L7x ControlLogix  controller

1. In Toolbox, expand Programmable Control Systems  and 1756 ControlLogix/GuardLogix  Systems.

2. Expand either Controllers, Standard  or Controllers, Safety.

3. Drag a 1756-L6x or L7x controller from Toolbox  to an unused slot on a chassis in Hardware Diagram.

4. (optional) In New Controller Graphic  on page 23, configure the controller settings:

◦ Name:  Enter a unique name.

◦ Controller Firmware Version:  Select a firmware version. The default value is the most recent firmware 

version.

◦ ACD File Name:  Enter a name for the Logix Designer  project. The default value is the controller name.

5. Select OK. In Hardware Diagram, the controller snaps into its slot in the chassis. Project Explorer  shows the 

controller in Devices.
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Add a 1756-L8x controller
Automation systems driven by 1756-L8x ControlLogix  controllers require one or more controllers to manage inputs, 

outputs, and run applications.

Prerequisites

• Add a 1756 ControlLogix  chassis  on page 22

To add a 1756-L8x controller

1. In Toolbox, expand Programmable Control Systems  and 1756 ControlLogix/GuardLogix  Systems.

2. Expand Controllers, Standard.

3. Drag a 1756-L8x controller from Toolbox  to an unused slot on a chassis in Hardware Diagram.

4. (optional) In New Controller Graphic  on page 23, configure the controller settings:

◦ Name:  Enter a unique name.

◦ Controller Firmware Version:  Select a firmware version. The default value is the most recent firmware 

version.

◦ ACD File Name:  Enter a name for the Logix Designer  project. The default value is the controller name.

◦ Address / Host Name:  Select a network type, then enter an IP address or host name.

5. Select OK. In Hardware Diagram, the controller snaps into its slot in the chassis. Project Explorer  shows the 

controller in Devices.

New Controller Graphic
How do I open New Controller Graphic?

When adding a controller to a project

1. In Toolbox, expand the Programmable Control Systems, controller family and Controllers  folders.

2. Drag the desired controller from Toolbox  to the Hardware Diagram.

3. (optional) In Enter Name, type a unique name for the controller, then select OK.

When editing an existing 1769/68 CompactLogix  controller

1. In the Hardware Diagram, right-click on a 1769/68 CompactLogix  controller, then select Configure 

CompactLogix  Chassis.

Use New Controller Graphic  to set firmware, project, and hardware settings for a new controller. Edit these settings 

after the controller is added to the project.

Settings that do not apply to the controller are hidden.

Setting Description Controllers

Controller Firmware Version Sets the controller firmware version. All

ACD File Name Sets the name of the controller project 

(.acd) file.

All

Bank 1 Contains the information of the first 

bank, for example, slot number, power 

supply, and cable type.

L3x and L4x
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Setting Description Controllers

Bank 1 is the parent chassis of the 

controller. If the system contains 

expansion banks, configure them in Bank 

2 and Bank 3.

Bank 2 Contains the information of the 

expansion bank, for example, slot 

number, power supply, and cable type.

L3x and L4x

Bank 3 Contains the information of the 

expansion bank, for example, slot 

number, and power supply.

L3x and L4x

Slots Left Specifies the number of 1769 slots to the 

left of the power supply in the bank.

The total number of slots to the left and 

slots to the right must be greater than 

zero.

L3x and L4x

Slots Right Specifies the number of 1769 slots to the 

right of the power supply in the bank.

The total number of slots to the left and 

slots to the right must be greater than 

zero.

L3x and L4x

Power Supply Specifies the power supply catalog 

number.

L3x and L4x

Cable Type Specifies the cable type between banks. 

After selecting a cable type, the banks are 

connected automatically.

There are three cable types, 1769-CRLx, 

1769-CRRx, and 1769-CLLx, where x  means 

the length of the cable (1 or 3):

• 1769-CRLx: connection from the 

right side of one bank to the left 

side of the next bank.

• 1769-CRRx: connection from the 

right side of one bank to the right 

side of the next bank.

• 1769-CLLx: connection from the left 

side of one bank to the left side of 

the next bank. This cable can be 

used only to connect banks 2 and 3.

L3x and L4x

Add 176x or 5069 hardware
Add a variety of 1768, 1769, and 5069 CompactLogix  controllers, banks, expansion slots, and modules to a Studio 5000 

Architect  project. Controllers, banks, slots, and modules appear in Hardware Diagram  and Project Explorer.
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Add a 1768-L4x controller
Automation systems driven by 1768-L4x CompactLogix  controllers require one or more controllers to manage inputs, 

outputs, and run applications.

To add a 1768-L4 CompactLogix  controller

1. In Toolbox, expand Programmable Control Systems, 176x/5069 CompactLogix  Systems, 1768 

CompactLogix  System, and either Controllers, Standard  or Controllers, Safety.

2. Drag a controller from Toolbox  to Hardware Diagram.

3. (optional) In New Controller Graphic, type a unique name for the controller and then OK.

4. In New Controller Graphic, configure the controller settings, and select OK:

◦ (optional) Name:  Enter a unique name.

◦ (optional) Description:  Enter a description. Cannot be longer than 128 characters.

◦ Controller Firmware Version:  Select a firmware version. The default value is the most recent firmware 

version.

◦ ACD File Name:  Enter a name for the Logix Designer  project. The default value is the controller name.

◦ Address / Host Name:  Select a network type, then enter an IP address or host name.

5. (optional) In New Bank Graphic, configure the controller settings:

◦ Slot Left:  Enter the number of left slots for each bank.

◦ Power Supply:  Select the power supply for each bank.

◦ Slot Right:  Enter the number of right slots for each bank.

◦ Cable Type:  Select a type of cable to connect banks 1 and 2 or banks 2 and 3.

6. Select OK. The CompactLogix  controller, banks, slots, power supplies, and cables appear in Hardware 

Diagram. Project Explorer  shows the CompactLogix  controller, banks, slots, and power supplies in 

Hardware Diagrams.

Add a 1769-L1x controller
Automation systems driven by 1769-L1x CompactLogix  controllers require one or more controllers to manage inputs, 

outputs, and run applications.

To add a 1769-L1x CompactLogix  controller

1. In Toolbox, expand Programmable Control Systems, 176x/5069 CompactLogix  Systems, 1769 

CompactLogix  System, and Controllers, Standard.

2. Drag a controller from Toolbox  to Hardware Diagram.

3. In New Controller Graphic, configure the controller settings:

◦ (optional) Name:  Enter a unique name.

◦ (optional) Description:  Enter a description. Cannot be longer than 128 characters.

◦ Controller Firmware Version:  Select a firmware version. The default value is the most recent firmware 

version.

◦ ACD File Name:  Enter a name for the Logix Designer  project. The default value is the controller name.

◦ Address / Host Name:  Select a network type, then enter an IP address or host name.

◦ Number of Expansion I/O Slots:  Enter the number of expansion slots.

4. Select OK. The CompactLogix  controller, banks, and expansion slots appear in Hardware Diagram. Project 

Explorer  shows the CompactLogix  controller, banks, and expansion slots in Devices.
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Add a 1769-L23x controller
Automation systems driven by 1769-L23x CompactLogix  controllers require one or more controllers to manage inputs, 

outputs, and run applications.

To add a 1769-L23x CompactLogix  controller

1. In Toolbox, expand Programmable Control Systems, 176x/5069 CompactLogix  Systems, 1769 

CompactLogix  System, and Controllers, Standard.

2. Drag a controller from Toolbox  to Hardware Diagram.

3. In New Controller Graphic, configure the controller settings:

◦ (optional) Name:  Enter a unique name.

◦ (optional) Description:  Enter a description. Cannot be longer than 128 characters.

◦ Controller Firmware Version:  Select a firmware version. The default value is the most recent firmware 

version.

◦ ACD File Name:  Enter a name for the Logix Designer  project. The default value is the controller name.

◦ Address / Host Name:  Select a network type, then enter an IP address or host name.

◦ Number of Expansion I/O Slots:  Enter the number of expansion slots.

4. Select OK. The CompactLogix  controller, banks, and expansion slots appear in Hardware Diagram. Project 

Explorer  shows the CompactLogix  controller, banks, and expansion slots in Devices.

Add a 1769-L24x or L27x controller
Automation systems driven by 1769-L24x or L27x CompactLogix  controllers require one or more controllers to manage 

inputs, outputs, and run applications.

To add a 1769-L24x or L27x CompactLogix  controller

1. In Toolbox, expand Programmable Control Systems, 176x/5069 CompactLogix  Systems, 1769 

CompactLogix  System, and Controllers, Standard.

2. Drag a controller from Toolbox  to Hardware Diagram.

3. In New Controller Graphic, configure the controller settings:

◦ (optional) Name:  Enter a unique name.

◦ (optional) Description:  Enter a description. Cannot be longer than 128 characters.

◦ Controller Firmware Version:  Select a firmware version. The default value is the most recent firmware 

version.

◦ ACD File Name:  Enter a name for the Logix Designer  project. The default value is the controller name.

◦ Address / Host Name:  Select a network type, then enter an IP address or host name.

◦ Number of Expansion I/O Slots:  Enter the number of expansion slots.

4. Select OK. The CompactLogix  controller, banks, and expansion slots appear in Hardware Diagram. Project 

Explorer  shows the CompactLogix  controller, banks, and expansion slots in Devices.

Add a 1769-L3x controller
Automation systems driven by 1769-L3x CompactLogix  controllers require one or more controllers to manage inputs, 

outputs, and run applications.
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To add a 1769-L3x CompactLogix  controller

1. In Toolbox, expand Programmable Control Systems, 176x/5069 CompactLogix  Systems, 1769 

CompactLogix  System, and either Controllers, Standard  or Controllers, Safety.

2. Drag a controller from Toolbox  to Hardware Diagram.

3. In New Controller Graphic, configure the controller settings, then click OK:

◦ (optional) Name:  Enter a unique name.

◦ (optional) Description:  Enter a description. Cannot be longer than 128 characters.

◦ Controller Firmware Version:  Select a firmware version. The default value is the most recent firmware 

version.

◦ ACD File Name:  Enter a name for the Logix Designer  project. The default value is the controller name.

◦ Address / Host Name:  Select a network type, then enter an IP address or host name.

4. (optional) In New Bank Graphic, configure the bank settings:

◦ Slot Left:  Enter the number of left slots for each bank.

◦ Power Supply:  Select the power supply for each bank.

◦ Slot Right:  Enter the number of right slots for each bank.

◦ Cable Type:  Select a type of cable to connect banks 1 and 2 or banks 2 and 3.

5. Select OK. The CompactLogix  controller, banks, slots, power supplies, and cables appear in Hardware 

Diagram. Project Explorer  shows the CompactLogix  controller, banks, slots, and power supplies in Devices.

Add a 5069-L3x controller
Automation systems driven by 5069-L3x CompactLogix  controllers require one or more controllers to manage inputs, 

outputs, and run applications.

To add a 5069-L3x CompactLogix  bank

1. In Toolbox, expand Programmable Control Systems, 176x/5069 CompactLogix  Systems, 5069 

CompactLogix  System, and Controllers.

2. Drag a controller from Toolbox  to Hardware Diagram.

3. In New Controller Graphic, configure the controller settings, then select OK:

◦ (optional) Name:  Enter a unique name.

◦ (optional) Description:  Enter a description. Cannot be longer than 128 characters.

◦ Controller Firmware Version:  Select a firmware version. The default value is the most recent firmware 

version.

◦ ACD File Name:  Enter a name for the Logix Designer  project. The default value is the controller name.

◦ Address / Host Name:  Select a network type, then enter an IP address or host name.

◦ Number of Expansion I/O Slots:  Enter the number of expansion slots.

4. Select OK. The CompactLogix  controller, banks, and slots, appear in Hardware Diagram. Project Explorer 

shows the CompactLogix  controller, banks, and slots in Devices.

Add a 5069-AEN2TR module
Add a 5069-AEN2TR communication module to connect remote modules to a 5069 controller.
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To add a 5069-AEN2TR communication module

1. In Toolbox, expand Programmable Control Systems, 176x/5069 CompactLogix  Systems, 5069 

CompactLogix  System, and Communication Modules.

2. Drag the 5069-AEN2TR  communication module from Toolbox  to Hardware Diagram.

3. In New 5069-AEN2TR Graphic  on page 30, configure the module settings, then select OK:

◦ (optional) Name:  Enter a unique name.

◦ Number of Expansion I/O Slots:  Enter the number of expansion slots.

4. Select OK. The 5069-AEN2TR, 5069 CompactLogix  bank and slots appear in Hardware Diagram. Project 

Explorer  shows the CompactLogix  controller, banks, and slots in Devices.

Add an expansion slot
Before adding a module to a 1769/68 CompactLogix  bank or  POINT I/O™   communication module, the controller must 

have an available expansion slot. Each controller has a certain number of expansion slots. Once a controller has 

reached its limit of expansion slots no further expansion slots can be added.

To add an expansion slot

• In Hardware Diagram, right-click the controller or an existing expansion slot, then select Insert Empty Slot 

After. A new expansion slot appears.

New Controller Graphic
How do I open New Controller Graphic?

When adding a controller to a project

1. In Toolbox, expand the Programmable Control Systems, controller family and Controllers  folders.

2. Drag the desired controller from Toolbox  to the Hardware Diagram.

3. (optional) In Enter Name, type a unique name for the controller, then select OK.

When editing an existing 1769/68 CompactLogix  controller

1. In the Hardware Diagram, right-click on a 1769/68 CompactLogix  controller, then select Configure 

CompactLogix  Chassis.

Use New Controller Graphic  to set firmware, project, and hardware settings for a new controller. Edit these settings 

after the controller is added to the project.

Settings that do not apply to the controller are hidden.

Setting Description Controllers

Controller Firmware Version Sets the controller firmware version. All

ACD File Name Sets the name of the controller project 

(.acd) file.

All

Bank 1 Contains the information of the first 

bank, for example, slot number, power 

supply, and cable type.

L3x and L4x
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Setting Description Controllers

Bank 1 is the parent chassis of the 

controller. If the system contains 

expansion banks, configure them in Bank 

2 and Bank 3.

Bank 2 Contains the information of the 

expansion bank, for example, slot 

number, power supply, and cable type.

L3x and L4x

Bank 3 Contains the information of the 

expansion bank, for example, slot 

number, and power supply.

L3x and L4x

Slots Left Specifies the number of 1769 slots to the 

left of the power supply in the bank.

The total number of slots to the left and 

slots to the right must be greater than 

zero.

L3x and L4x

Slots Right Specifies the number of 1769 slots to the 

right of the power supply in the bank.

The total number of slots to the left and 

slots to the right must be greater than 

zero.

L3x and L4x

Power Supply Specifies the power supply catalog 

number.

L3x and L4x

Cable Type Specifies the cable type between banks. 

After selecting a cable type, the banks are 

connected automatically.

There are three cable types, 1769-CRLx, 

1769-CRRx, and 1769-CLLx, where x  means 

the length of the cable (1 or 3):

• 1769-CRLx: connection from the 

right side of one bank to the left 

side of the next bank.

• 1769-CRRx: connection from the 

right side of one bank to the right 

side of the next bank.

• 1769-CLLx: connection from the left 

side of one bank to the left side of 

the next bank. This cable can be 

used only to connect banks 2 and 3.

L3x and L4x
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New 5069-AEN2TR Graphic
How do I open New 5069-AEN2TR Graphic?

1. In Toolbox, expand Programmable Control Systems, 176x/5069 CompactLogix  Systems, 5069 

CompactLogix  System, and Communication Modules.

2. Drag the 5069-AEN2TR  communication module from Toolbox  to Hardware Diagram.

Use New 5069-AEN2TR Graphic  to set a name and number of expansion slots for a new 5069-AEN2TR 

communication module.

Add modules
Add or remove modules for 1756 ControlLogix, 1769/68 CompactLogix, 1794/97 FLEX I/O, and 1734 POINT I/O  hardware. 

Although modules can be added to a project without a related chassis or controller, most modules require a controller 

to operate properly. Modules appear in Hardware Diagram  and Project Explorer.

Add a module
Automation systems require one or more modules to drive inputs, outputs, or handle communications.

Prerequisites

• Add 1756 ControlLogix, 1769/68 CompactLogix, 1794/97 FLEX I/O, or 1734 POINT I/O  hardware to the project.

To add a module

1. In Toolbox, expand the product family and module type.

2. Drag the module from Toolbox  to an unused slot on a chassis, bank, or DIN rail in Hardware Diagram.

Tip:   The unused slot turns green if it is compatible or red if it is not compatible. 

3. (optional) In New Module Graphic, enter a unique name for the module, then select OK. In Hardware 

Diagram, the module snaps into its slot in the chassis. Project Explorer  shows the module in Projects  and 

Devices.

About unsupported modules
Modules updated or imported from a controller or Logix Designer  project may not be supported in Studio 5000 

Architect. When a module is not supported, Studio 5000 Architect  displays an unsupported module image in the 

appropriate chassis, DIN rail, or expansion slot.

Unsupported modules have these limitations:

• Cannot change the properties of unsupported modules.

• Cannot move unsupported modules to another chassis, DIN rail, or expansion slot.

• Cannot cut, copy, or paste unsupported modules. However, cutting or copying its chassis or DIN rail copies 

the unsupported module.
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For this family of devices: Studio 5000 Architect  displays this image:

1756 ControlLogix

1768/69 CompactLogix

1794/97 FLEX I/O

Add Kinetix servo drives
Add Kinetix  servo drives  on page 31 to operate multi-axis motion controls using a Logix Designer  project. Servo 

drives appear in Hardware Diagram  and Project Explorer.

IMPORTANT:   Using Kinetix  drives in Studio 5000 Architect  requires Logix Designer  24.x or later. 

Add a Kinetix servo drive
Add a Kinetix  servo drive to run multi-axis motion controls from a Logix Designer  project.

IMPORTANT:   Using Kinetix  drives in Studio 5000 Architect  requires Logix Designer  24.x or later. 

To add a Kinetix  servo drive

1. In Toolbox, expand Motion Control  and Servo Drives.

2. Expand the drive type and Kinetix  product family.

3. Drag a servo drive from Toolbox  to Hardware Diagram.

4. In New Servo Drive Graphic  on page 32, configure the drive settings:

◦ (optional) Name:  Enter a unique name.

◦ (optional) Description: Enter a description. Cannot be longer than 128 characters.

Rockwell Automation, Inc. ARCH-GR001M-EN-E - January 2024 31



Chapter 5        Add new components

◦ Address / Host Name:  Select a network type, then enter an IP address or host name.

◦ (optional) Change DC BUS Supply/Line Filter:  Select either Single  or Multiple  supply/line filters, then 

select a power supply.

5. Select OK. The servo drive appears in Hardware Diagram. Project Explorer  shows the servo drive in 

Devices.

New Servo Drive Graphic
How do I open New Servo Drive Graphic?

1. In Toolbox, expand Motion Control  and Servo Drives.

2. Expand the drive type and Kinetix  product family.

3. Drag a servo drive from Toolbox  to Hardware Diagram.

Use New Servo Drive Graphic  to set description, and network settings for a new servo drive.

IMPORTANT:   Using Kinetix  drives in Studio 5000 Architect  requires Logix Designer  24.x or later. 

The Kinetix  Servo Drives Configuration  settings are:

Setting Description

Type Sets the type of the servo drive.

Vendor Shows the vendor information of the servo drive.

Name Sets the name of the servo drive.

Description Sets the description of the servo drive. Cannot be longer than 

128 characters.

Change DC BUS Supply/Line Filter Sets the number and type of power supply/line filters for the 

servo drive. Only shown for Kinetix  5700 devices.

Address/Host Name Sets the network configuration of the servo drive.

• Private Network: Select the value from the list, from 1 to 

254.

• IP Address: Enter a unique IP address to identify the servo 

drive on the IP network.

• Host Name: Enter a fully qualified domain name, such as 

servodrive.yourcompany.com.

Add PowerFlex drives
Add a PowerFlex  drive  on page 32 to connect and control it in a FactoryTalk  system.

IMPORTANT:   Using PowerFlex  drives in Studio 5000 Architect  requires Logix Designer  24.x or later. 

Add a PowerFlex drive
Add a PowerFlex  drive to control it from a Logix Designer  project.
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IMPORTANT:   Using PowerFlex  drives in Studio 5000 Architect  requires Logix Designer  24.x or later. 

To add a PowerFlex  drive

1. In Toolbox, expand Drives  and Drives, AC Low Voltage.

2. Expand either Architecture Drives  or Compact Drives, then expand the product family folder.

3. Drag the drive from Toolbox  to Hardware Diagram.

4. In New PowerFlex  Graphic  on page 33, configure the PowerFlex  settings:

◦ (optional) Name:  Enter a unique name.

◦ (optional) Description:  Enter a description. Cannot be longer than 128 characters.

◦ Address / Host Name, set the IP address or host name for the drive.

5. Select OK. The drive appears in the Hardware Diagram  pane. Project Explorer  shows the drive in Devices.

New PowerFlex Graphic
How do I open New PowerFlex  Graphic?

1. In Toolbox, expand Drives  and Drives, AC Low Voltage.

2. Expand either Architecture Drives  or Compact Drives, then expand the product family folder.

3. Drag the drive from Toolbox  to Hardware Diagram.

Use New PowerFlex  Graphic  to add PowerFlex  drives to a hardware diagram.

IMPORTANT:   Using PowerFlex  drives in Studio 5000 Architect  requires Logix Designer  24.x or later. 

The New PowerFlex  Graphic  settings are:

Field Description

Name Sets a unique name for the drive.

Description Sets the description for the drive. Cannot be longer than 128 

characters.

Address / Host Name Sets the IP address or host name for the drive.

Always show this dialog If unchecked, New PowerFlex  Graphic  does not open the next 

time a drive is added to the Hardware Diagram. New drives use 

the default settings.

Add PanelView Plus and MobileView
Add or remove PanelView Plus  and MobileView  graphic terminals to the project. Adding a PanelView Plus  or 

MobileView  terminal creates a new FactoryTalk View ME  application.

Add a PanelView Plus  graphic terminal
Add a variety of PanelView Plus  graphic terminals to a Studio 5000 Architect  project. Adding a PanelView Plus 

terminal creates a new FactoryTalk View ME  application.
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To add a PanelView Plus  graphic terminal

1. In Toolbox, expand Visualization  and Graphic Terminals.

2. Expand the PanelView Plus  model family and size items.

3. Drag a PanelView Plus  model from Toolbox  to Hardware Diagram.

4. In New PanelView Plus  Graphic  on page 35, configure settings for the PanelView Plus  terminal:

◦ (optional) Name:  Enter a unique name for the terminal.

◦ (optional) Description:  Enter a description of the terminal. Cannot be longer than 128 characters.

◦ IP Address:  Enter a static IP address for the terminal.

◦ (optional) Catalog Number:  Select a catalog number from the list.

5. Click OK.

6. In New PanelView Plus  Project  on page 35, configure settings for the new FactoryTalk View ME  application:

◦ Name:  Enter a unique name for the application. Studio 5000 Architect  creates a new FactoryTalk View 

ME  application.

◦ (optional) Description:  Enter a description of the application. Cannot be longer than 128 characters.

◦ (optional) Scale Replace Displays:  Select to scale objects in Replace displays to the resolution of the 

panel.

◦ (optional) Scale OnTop Displays:  Select to scale objects in OnTop displays to the resolution of the 

panel.

◦ (optional) Language:  Select a language for the application.

7. Select OK. The PanelView Plus  graphic terminal appears in Hardware Diagram  and in Project Explorer  under 

Devices. The FactoryTalk View ME  application appears in Project Explorer  under Projects.

Add a MobileView terminal
Add a variety of MobileView  graphic terminals to the Studio 5000 Architect  project. Adding a MobileView  terminal 

creates a new FactoryTalk View ME  application.

To add a MobileView  graphic terminal

1. In Toolbox, expand Visualization  and Mobile Terminals.

2. Expand the MobileView  model family and size items.

3. Drag a MobileView  model from Toolbox  to Hardware Diagram.

4. In New MobileView  Graphic  on page 35, configure settings for the MobileView  terminal:

◦ Name:  Enter a unique name for the terminal.

◦ (optional) Description:  Enter a description of the terminal. Cannot be longer than 128 characters.

◦ IP Address:  Enter a static IP address for the terminal.

◦ (optional) Catalog Number:  Select a catalog number from the list.

5. Select OK.

6. In New MobileView  Project  on page 35, configure settings for the new FactoryTalk View ME  application:

◦ Name:  Enter a unique name for the application. Studio 5000 Architect  creates a new FactoryTalk View 

ME  application.

◦ (optional) Description:  Enter a description of the application. Cannot be longer than 128 characters.

◦ (optional) Scale Replace Displays:  Select to scale objects in Replace displays to the resolution of the 

panel.
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◦ (optional) Scale OnTop Displays:  Select to scale objects in OnTop displays to the resolution of the 

panel.

◦ (optional) Language:  Select a language for the application.

7. Select OK. The MobileView  graphic terminal appears in Hardware Diagram  and in Project Explorer  under 

Devices. The FactoryTalk View ME  application appears in Project Explorer  under Projects.

New PanelView Plus Graphic
How do I open New PanelView Plus  Graphic?

1. In Toolbox, expand Visualization  and Graphic Terminals.

2. Expand the PanelView Plus  model family and size items.

3. Drag a PanelView Plus  model from Toolbox  to Hardware Diagram.

Use New PanelView Plus  Graphic  to set name, description, and IP address settings for a new PanelView Plus  graphic 

terminal. These settings are editable after the project contains the PanelView Plus  terminal.

New PanelView Plus Project
How do I open New PanelView Plus  Project?

1. In Toolbox, expand Visualization  and Graphic Terminals.

2. Expand the PanelView Plus  model family and size items.

3. Drag a PanelView Plus  model from Toolbox  to Hardware Diagram.

4. Configure the settings in New PanelView Plus  Graphic, then select OK.

Use New PanelView Plus  Project  to set the name and description for a new PanelView Plus  project. The name and 

description are editable after the project is part of the Studio 5000 Architect  project.

New MobileView Graphic
How do I open New MobileView  Graphic?

1. In Toolbox, expand Visualization  and Mobile Terminals.

2. Expand the MobileView  model family and size items.

3. Drag a MobileView  model from Toolbox  to Hardware Diagram.

Use New MobileView  Graphic  to set name, description, and IP address settings for a new MobileView  graphic 

terminal. These settings are editable after the MobileView  terminal is in the project.

New MobileView Project
How do I open New MobileView  Project?

1. In Toolbox, expand Visualization  and Graphic Terminals.

2. Expand the MobileView  model family and size items.

3. Drag a MobileView  model from Toolbox  to Hardware Diagram.

4. Configure the settings in New MobileView  Graphic, then select OK.

Use New MobileView  Project  to set the name and description for a new MobileView  project. The name and 

description are editable after the project is part of the Studio 5000 Architect  project.
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PanelView Plus Properties settings
The PanelView Plus  Properties  settings define name, description, and network settings for PanelView Plus  graphic 

terminals. Set these settings from New PanelView Plus  Graphic  on page 35 when adding a PanelView Plus  terminal 

or from the Properties General  tab when editing a PanelView Plus  terminal.

The PanelView Plus  Properties settings are:

Setting Description

Name Sets the PanelView Plus  terminal name.

Description Sets the PanelView Plus  terminal description. 255 character 

maximum.

IP Address Sets the unique address that identifies the PanelView Plus 

terminal on the IP network.

Catalog Number Sets a PanelView Plus  terminal catalog number.

MobileView Properties settings
The MobileView  Properties  settings define name, description, and network settings for MobileView  components. Set 

these settings in New MobileView  Graphic  on page 35 when adding a MobileView  terminal or from the Properties 

General  tab when editing a MobileView  terminal.

The MobileView  Properties settings are:

Setting Description

Name Sets the MobileView  name.

Description Sets the MobileView  description. 128 character maximum.

IP Address Sets the unique address that identifies the MobileView  on the IP 

network.

Catalog Number Sets a MobileView  catalog number.

Add computers
Add or remove computers from your project. Computers represent the hardware that serve FactoryTalk View SE  and 

FactoryTalk View ME  applications to visualization devices. Computers appear in Hardware Diagram  and Project 

Explorer.

Add a computer
Add a computer to a Studio 5000 Architect  project to represent a host machine for FactoryTalk View SE  and 

FactoryTalk View ME  servers.

To add a computer

1. In Toolbox, expand the Computers  and Generic Computer  folders.

2. Drag a computer from Toolbox  to Hardware Diagram.
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3. In New Computer Graphic  on page 37, configure these settings:

◦ Name:  Type a unique name for the computer.

◦ (optional) Description:  Type a description for the computer. Cannot be longer than 128 characters.

◦ Computer Name:  Enter or select the computer's hostname.

4. Select OK. The computer appears in the Hardware Diagram  and in Project Explorer  under Devices.

New Computer Graphic
How do I open New Computer Graphic?

1. In Toolbox, expand the Computers  and Generic Computer  folders.

2. Drag a computer from Toolbox  to the Hardware Diagram.

Use New Computer Graphic to set the name, description, and host name for a new computer. Edit these settings 

after adding the computer to the project.

The computer properties are:

Field Description

Name Sets the name for the computer.

Description Sets the description for the computer. Cannot be longer than 

128 characters.

Computer Name Sets the unique name that identifies the computer on the 

network.

Add visualization applications
Visualization stations and servers represent software applications that provide visual, communication, alarm, and 

event data to FactoryTalk View SE  and FactoryTalk View ME  components. Visualization stations and servers display in 

Project Explorer.

Add a FactoryTalk View SE  Station
If integrating an automation system with FactoryTalk View Site Edition visualization devices, add a FactoryTalk View 

Site Edition station to the Studio 5000 Architect  project.

Prerequisites

• Add a computer  on page 36

To add a FactoryTalk View Site Edition Station

1. In Toolbox, expand Visualization  and Stations.

2. Drag a FactoryTalk View SE Local  or FactoryTalk View SE Network station from Toolbox  to a computer in 

Hardware Diagram.

3. In New Computer Graphic, configure settings for the application:

◦ Name:  Enter a unique name for the application. The Studio 5000 Architect  creates a new FactoryTalk 

View Site Edition application.

◦ (optional) Description:  Enter a description of the application. Cannot be longer than 255 characters.

◦ (optional) Language:  Select a language for the application.

Rockwell Automation, Inc. ARCH-GR001M-EN-E - January 2024 37



Chapter 5        Add new components

4. In New View SE Station Project, configure settings for the HMI server:

◦ (optional) Area:  Enter a View SE area to assign the HMI server to the area.

◦ Name:  Enter a unique name for the HMI server.

◦ (optional) Description:  Enter a description of the HMI server. Cannot be longer than 255 characters.

5. (optional) In New View SE Station Project, select additional server functions:

◦ New FactoryTalk Linx  Server:  Select if this computer is also a FactoryTalk Linx  server. The Studio 

5000 Architect  creates a new FactoryTalk Linx  Server and displays New FactoryTalk Linx Server Project 

on page 41.

◦ New Tag Alarm and Event Server:  Select if this computer is also a Tag Alarm & Events server. Studio 

5000 Architect  creates a new Tag Alarm and Event server and displays New Tag Alarm and Event 

Server Project.

6. Select OK.

Project Explorer  shows the View SE Station project in Projects.

Add a FactoryTalk View ME  Station
If integrating an automation system with View Machine Edition (ME) Visualization devices, add a View ME Station to 

the Studio 5000 Architect  project.

Tip:   RSLinx Enterprise  is renamed to FactoryTalk Linx. Some software applications may refer to RSLinx 

Enterprise. FactoryTalk Linx  is compatible with all software applications that used RSLinx Enterprise. 

Prerequisites

• Add a computer  on page 36

To add a FactoryTalk View Machine Edition Station

1. In Toolbox, expand Visualization and Stations.

2. Drag FactoryTalk View Machine Edition  from Toolbox  to a computer in Hardware Diagram.

3. In New View ME Station Project  on page 41, configure the station settings:

◦ Name: Enter a unique name.

◦ (optional) Description: Enter a description. Cannot be longer than 255 characters.

◦ (optional) Language: Select a project language.

◦ (optional) Resolution: Select a project resolution.

◦ (optional) Scale Replace Displays: Select to scale objects in Replace displays to the resolution of the 

panel.

◦ (optional) Scale OnTop Displays: Select to scale objects in OnTop  displays to the resolution of the 

panel.

4. Select OK.

In Hardware Diagram, Studio 5000 Architect  displays a new computer. Project Explorer shows the View ME 

Station project in Projects.

Add a FactoryTalk View SE  Server Project
If integrating an automation system with FactoryTalk View SE  Visualization devices, add a FactoryTalk View SE  Server 

project to the Studio 5000 Architect  project.
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Prerequisites

• Add a computer  on page 36

To add a FactoryTalk View SE  Server Project

1. In Toolbox, expand Visualization  and Servers.

2. Drag FactoryTalk View SE Server from Toolbox  to a computer in Hardware Diagram.

3. In New FactoryTalk View SE Server Project, configure the Application  settings:

◦ Name:  Enter a unique name.

◦ (optional) Description:  Enter a description. Cannot be longer than 255 characters.

◦ (optional) Language: Select a project language.

4. In New FactoryTalk View SE Server Project, configure settings for the HMI server:

◦ (optional) Area:  Enter a View SE area to assign the HMI server to the area.

◦ Name:  Enter a unique name for the HMI server.

◦ (optional) Description:  Enter a description of the HMI server. Cannot be longer than 255 characters.

5. (optional) In New FactoryTalk View SE Server Project, select additional server functions:

◦ New FactoryTalk Linx  Server:  Select if this computer is also a FactoryTalk Linx  server. The Studio 

5000 Architect  creates a new FactoryTalk Linx  Server and displays New FactoryTalk Linx  Server 

Project.

◦ New Tag Alarm and Event Server:  Select if this computer is also a Tag Alarm & Events server. The 

Studio 5000 Architect  creates a new Tag Alarm and Event server and displays New Tag Alarm and 

Event Server Project.

6. Select OK. Project Explorer  shows the View SE Server project in Projects.

Add a FactoryTalk Linx  Server Project
If an automation system has a dedicated FactoryTalk Linx  server, add a FactoryTalk Linx  server project to the Studio 

5000 Architect  project.

Prerequisites

• Add a computer  on page 36

To add a FactoryTalk Linx  Server Project

1. In Toolbox, expand Visualization  and Servers.

2. Drag FactoryTalk Linx  Server  from Toolbox  to a computer in Hardware Diagram.

3. In New FactoryTalk Linx Server Project  on page 41, on the General  tab, enter the Application  settings.

◦ Type:  Select a View SE application type.

◦ Name: Enter a unique name for the application. The Studio 5000 Architect  creates a new FactoryTalk 

View SE  application.

◦ (optional) Description:  Enter a description of the application. Cannot be longer than 255 characters.

◦ (optional) Language:  Select a language for the application.

4. On the same tab, enter the FactoryTalk Linx  Server  settings.

◦ (optional) Area:  Enter a View SE area to assign the FactoryTalk Linx  server to the area. If the area does 

not exist, the Studio 5000 Architect  creates a new area.

◦ Name:  Enter a unique name for the server.
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◦ (optional) Description:  Enter a description of the server. Cannot be longer than 255 characters.

◦ (optional) Create HMI Server:  Select to create an associated HMI server.

5. (optional) To select alarm and event options, select the Alarms and Events  tab:

◦ Enable alarm and event support:  Select if this server monitors alarm and event tags.

◦ Enable server-assigned priorities:  Select and assign severity ranges if this server has custom 

warning levels for alarms and events.

6. Select OK.

Project Explorer  shows the FactoryTalk Linx  server project in Projects.

Add a Tag Alarm and Event Server
If the automation system has a dedicated FactoryTalk Alarms and Events server, add a Tag Alarm and Event server to 

the Studio 5000 Architect  project.

Prerequisites

• Add a computer  on page 36

To add a Tag Alarm and Event Server

1. In Toolbox, expand Visualization  and Servers.

2. Drag Tag Alarm and Event Server  from Toolbox  to a computer in Hardware Diagram.

3. In New Tag Alarm and Event Server Project  on page 41, enter the Application  settings:

◦ Type:  Select a View SE application type.

◦ Name: Enter a unique name for the application. If entering a unique name, the Studio 5000 Architect 

creates a new FactoryTalk View SE  application.

◦ (optional) Description:  Enter a description of the application. Cannot be longer than 255 characters.

◦ (optional) Language:  Select a language for the application.

4. In New Tag Alarm and Event Server Project, enter the Tag Alarm and Event Server  settings:

◦ (optional) Area:  Enter a View SE area to assign the tag server to the area. If entering a unique area, the 

Studio 5000 Architect  creates a new area.

◦ Name:  Enter a unique name for the server.

◦ (optional) Description:  Enter a description of the server. Cannot be longer than 255 characters.

◦ (optional) Create HMI Server:  Select to create an associated HMI server.

5. (optional) In the Priorities  tab of New Tag Alarm and Event Server Project, enter the Priority settings.

◦ Enable server-assigned priorities:  Select to change default event ranges.

◦ Urgent:  Set the low threshold for Urgent level events.

◦ High:  Set the low threshold for High level events.

◦ Medium:  Set the low threshold for Medium level events.

6. Select OK. Project Explorer  shows the Tag Alarm and Event server project in Projects.

New Site Edition Project
How do I open New Site Edition Project?

1. In Toolbox, expand the Visualization  and Stations  folders.

2. Drag FactoryTalk View Site Edition Station  from Toolbox  to a computer in the Hardware Diagram.
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Use New Site Edition Project  to set application and HMI server settings for a new local or network distributed Site 

Edition project. Edit these settings  on page 41 after the Site Edition project is added to the Studio 5000 Architect 

project.

New Machine Edition Station Project
How do I open New Machine Edition Station Project?

1. In Toolbox, expand the Visualization  and Stations  folders.

2. Drag FactoryTalk View ME Station  from Toolbox  to a computer in the Hardware Diagram.

Use New Machine Edition Station Project  to set name, description, resolution, scaling options, and language for a 

new FactoryTalk View Machine Edition project. Edit these settings  on page 42 after the FactoryTalk View Machine 

Edition project is added to the Studio 5000 Architect  project.

New Tag Alarm and Event Server
How do I open New Tag Alarm and Event Server Project?

1. In Toolbox, expand the Visualization  and Servers  folders.

2. Drag the Tag Alarm and Event Server  from Toolbox  to a computer in the Hardware Diagram.

Use New Tag Alarm and Event Server Project  to set server and alarm properties for a new Tag Alarm and Event 

Server.

New FactoryTalk Linx  Server Project
How do I open New FactoryTalk Linx  Server Project?

1. In Toolbox, expand the Visualization  and Servers  folders.

2. Drag the FactoryTalk Linx  Server  from Toolbox  to a computer in the Hardware Diagram.

Use New FactoryTalk Linx  Server Project  to set application, server, and alarm and event settings for a new 

FactoryTalk Linx  server

FactoryTalk View SE  Project settings
The FactoryTalk View Site Edition Project  settings define application and HMI server settings for a Site Edition 

project. Set these settings from New Site Edition Project  on page 40 when adding a local or network server or from 

the Properties General  tab when editing a Site Edition project.

The FactoryTalk View Site Edition Project  application and HMI server settings are:

Application Field Description

Type Specifies the project type for the FactoryTalk View Site Edition 

project.

Can only be set when adding an HMI, FactoryTalk Linx, or Tag 

Alarm and Event server without a station.

Name Specifies the name for the FactoryTalk View Site Edition 

project. The project name must not be empty.

Description Specifies the description for the FactoryTalk View Site Edition 

project. Cannot be longer than 255 characters.
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Application Field Description

Language Specifies the display language for the FactoryTalk View Site 

Edition project.

The FactoryTalk View Site Edition Project  HMI server settings are:

HMI Server Field Description

Area Specifies the area for the project's HMI server.

• If the area name is unique, a new area is created as a 

child of the FactoryTalk View Site Edition project. The HMI 

server is added as a child of the new area.

• If the area name already exists, the HMI server is added as 

a child of the specified area.

• If the area name is blank, the HMI server is added as a 

child of the FactoryTalk View Site Edition project.

Cannot be set when adding or editing a FactoryTalk View Site 

Edition Local Station.

Name Specifies the name for the project's HMI server. The HMI server 

name must not be empty.

Cannot be set when adding or editing a FactoryTalk View Site 

Edition Local Station.

Description Specifies the description for the project's HMI server.

The FactoryTalk View Site Edition Project  server settings are:

Server Setting Description

New FactoryTalk Linx  Server If checked, opens New FactoryTalk Linx  Server  on page 41.

This check box is only available when adding a new project.

New Tag Alarm and Event Server If checked, opens New Tag Alarm and Event Server  on page 

41.

This check box is only available when adding a new project.

FactoryTalk View ME  Project settings
The FactoryTalk View Machine Edition Project  settings define name, description, language, resolution, and scaling 

options for a FactoryTalk View ME  application. Set when adding a FactoryTalk View ME  application from New ME 

Station Project  on page 41 or when editing a FactoryTalk View ME  application from the Properties General  tab.

The FactoryTalk View ME  Project  settings are:

Setting Description

Name Sets the FactoryTalk View ME  application name. The project 

name must not be empty.

Description Sets the FactoryTalk View ME  application description. 255 

character maximum.

Language Sets the FactoryTalk View ME  application display language.
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Setting Description

Resolution Sets the FactoryTalk View ME  application target resolution.

Scale Replace Displays Set if objects in Replace displays should be scaled to the 

resolution of the panel.

Scale OnTop Displays Set if objects in OnTop displays should be scaled to the 

resolution of the panel.

Ensure runtime application can execute on PanelView Plus  7 

Standard

Set if an application should be compatible with both PanelView 

Plus 7 Performance  and PanelView Plus 7 Standard  graphic 

terminals.

Tag Alarm and Event Server settings
The  Tag Alarm and Event Server General  settings define server settings for a Tag Alarm and Event server. Set from 

the General tab of New Tag Alarm and Event Server  when adding a new Tag Alarm and Event server or from the 

Properties - General tab when editing a Tag Alarm and Event server.

The Tag Alarm and Event Server Priorities  settings define settings for a Tag Alarm and Events server. Set from the 

Priorities tab of New Tag Alarm and Event Server Project  on page 41 when adding a new Tag Alarm and Events 

server or from the Priorities tab when editing a Tag Alarm and Events server.

General settings
The General  settings are:

Tag Alarm and Event Server Field Description

Area Specifies the area for the Tag Alarm and Event server.

• If the area name is unique, creates a new area as a child 

of the FactoryTalk View Site Edition project. Adds the Tag 

Alarm and Event server as a child of the new area.

• If the area name already exists, adds the Tag Alarm and 

Event server as a child of the specified area.

• If the area name is blank, adds the Alarm and Event server 

as a child of the FactoryTalk View Site Edition project.

Cannot set when the project type is a FactoryTalk View Site 

Edition Local Station.

Name Specifies the name for the Tag Alarm and Event server. The 

server name cannot be empty.

Description Specifies the description for the server. 255 character 

maximum.

The server settings are:

Server Setting Description

Create HMI Server If checked, opens New HMI Server.

This check box is only available when adding a new project.
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Priorities settings
The Tag Alarm and Event Server Priorities  settings are:

Setting Description

Enable server-assigned priorities If selected, can set custom priority values for Urgent, High, and 

Medium priority events.

Urgent Specifies the priority at which an Urgent priority alarm or event 

are created.

High Specifies the priority at which a High priority alarm or event are 

created.

Medium Specifies the priority at which a Medium priority alarm or event 

are created.

FactoryTalk Linx Server settings
The FactoryTalk Linx  Server General settings define options for a FactoryTalk Linx  server. Configure these settings 

from the General  tab of New FactoryTalk Linx  Server  when adding a FactoryTalk Linx  server or from the Properties 

> General  tab when editing a FactoryTalk Linx  server.

The FactoryTalk Linx  Server Alarms and Events  settings define alarm and event settings for a FactoryTalk Linx 

server. Set from the Alarms and Events  tab of New FactoryTalk Linx  Server  when adding a new FactoryTalk Linx 

server or from the Properties Alarms and Events  tab when editing a FactoryTalk Linx  server.

General tab settings
The general settings of a FactoryTalk Linx  Server are:

FactoryTalk Linx  Server setting Description

Area Specifies the area for the FactoryTalk Linx  server.

• If the area name is unique, a new area is created as a child 

of the FactoryTalk View SE  project. The FactoryTalk Linx 

server is added as a child of the new area.

• If the area name already exists, the FactoryTalk Linx 

server is added as a child of the specified area.

• If the area name is blank, the FactoryTalk Linx  server is 

added as a child of the FactoryTalk View SE  project.

Cannot set when the project type is a FactoryTalk View SE  Local 

Station.

Name Specifies the name for the FactoryTalk Linx  server. The 

FactoryTalk Linx  server name must not be empty.

Description Specifies the description for the FactoryTalk Linx  server. 255 

character maximum.

The server settings are:
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Server Setting Description

Create HMI Server If checked, opens New HMI Server.

This check box is only available when adding a new project.

Alarms and Events tab settings
The FactoryTalk Linx  Server Alarms and Events settings are:

Setting Description

Enable alarm and event support If selected, sets the FactoryTalk Linx  Data Server to act as an 

Alarm and Event server.

Enable server-assigned priorities If selected, enables custom priority values for Urgent, High, and 

Medium priority events.

Urgent Sets the priority at which an Urgent priority alarm or event is 

created.

High Sets the priority at which a High priority alarm or event is 

created.

Medium Sets the priority at which a Medium priority alarm or event is 

created.
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Import existing components
A Studio 5000 Architect  project contains one or more components. Each component represents a hardware device, 

software project, visualization server, or document. Components appear in Hardware Diagram  and Project Explorer.

Import existing components from a project file or online controller to add them to a Studio 5000 Architect  project. 

Once added, connect components to networks and configure relationships to share tags and control an automation 

system.

Import a project from a file
Import Logix Designer  project files (.acd) to a Studio 5000 Architect  project. Studio 5000 Architect  adds the controller, 

chassis or DIN rail, and all associated modules, tags, and aliases to the project.

If the imported project contains unknown or unsupported modules, Studio 5000 Architect  stops the import operation.

If the imported project contains produced or consumed tags using user defined data types, define the user defined 

data type in the producer controller before committing the hardware diagram.

To import a controller project from a file

1. In Hardware Diagram, right-click on a blank area of the hardware diagram, then select Add Controller 

Project.

2. In Open, locate and select the project file to add, then select Open.

3. If importing a 1769 controller, in Bank Configuration, change the configuration to match your physical 

controller, then select OK.

4. In Confirm Update Changes  on page 48, select OK. The controller, chassis or DIN rail, and all associated 

modules appear in Hardware Diagram.

NOTE:   Select Cancel if the project contains unknown or unsupported modules. Remove 

unsupported modules in Logix Designer and try again. 

Import a project from a controller
Import a controller project to the Studio 5000 Architect  project from an online controller using either RSLinx Classic 

or FactoryTalk Linx. Studio 5000 Architect  adds the controller, chassis or DIN rail, and all associated modules, tags, 

and aliases to the project.

The Import option is only available for the modules supported by Studio 5000 Architect. Locate the children node 

when choosing modules to make sure that the selected modules are supported by Studio 5000 Architect.

If the imported project contains produced or consumed tags using user defined data types, define the user defined 

data type in the producer controller before committing the hardware diagram.

Studio 5000 Architect also supports FactoryTalk Logix Echo, a new type of controller emulator. The following steps 

use physical controller as an example. The steps also apply to emulated controller. Before you import a controller 

project from an online emulator, create an emulated controller in FactoryTalk Logix Echo and download a Logix 

Designer project to the emulated controller.
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NOTE:   Studio 5000 Architect supports importing all variants of emulated 1756-L8x ControlLogix and 

GuardLogix controllers. 

To import a controller project from an online controller

1. In Hardware Diagram, right-click on a blank area of the hardware diagram, then select Import from Online 

Controller....

2. In Import from Online Controller, in Communication Software  select either RSLinx Classic  or FactoryTalk 

Linx.

3. Browse the network tree to select the controller to import into your project, then select Import.

4. In Choose Matching Controller Configuration File  on page 48, perform one of these steps:

◦ To create a new project file, select Create New.

◦ To use controller settings from a project file in the list, select the file, then select Select.

◦ To use controller settings from a different project file, select Browse, then add the file to the list. Once 

Studio 5000 Architect  verifies the validity of the file, select Select.

5. If importing a 1769 controller, in Bank Configuration, modify the configuration to match the physical 

controller, then select OK.

6. In Confirm Update Changes  on page 48, select OK.

Import an application from a file
Import a FactoryTalk View  application to the Studio 5000 Architect  project. Studio 5000 Architect  adds the associated 

PanelView Plus  or MobileView  terminal, tags, displays, global objects, images, macros, and servers to the project.

To import a FactoryTalk View  application from a file

1. In Hardware Diagram, right-click on a blank area of the hardware diagram, then select Add Existing 

FactoryTalk View Project.

2. In Add Existing FactoryTalk View Project  on page 49, select an application and its settings:

◦ Application Type:  Select a type of FactoryTalk View  application.

◦ Applications:  Select the application to import.

◦ Language:  Select a language for the application.

◦ Diagram to add discovered hardware to:  Select a hardware diagram where Studio 5000 Architect 

imports the components.

3. Select OK.

4. In Update Summary, review the changes, then select OK.

The FactoryTalk View  application displays in Project Explorer. If importing a FactoryTalk View ME 

application, a PanelView Plus  or MobileView  terminal is added to the hardware diagram and its catalog 

number is set based on the station resolution of the project.

Select Online Controller to Import
How do I open Select Online Controller to Import?

• From the Hardware Diagrams  menu, select Import from Online Controller...

Select Online Controller to Import  lists controllers connected to the network. Select a controller to import settings 

from the online controller to settings in the Studio 5000 Architect  project.
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Choose a configuration file
How do I open Choose Matching Controller Configuration File?

If you are importing a controller from an online controller

1. Select Hardware Diagrams > Import from Online Controller...

2. In Select Online Controller to Import, browse the network, select the controller to import into the project, 

then click Select.

If you are updating a hardware diagram with an online controller

• Select Use external controller configuration file  in Select Online Controller to Update.

Choose Matching Controller Configuration  lists existing project files that are compatible with the controller you are 

importing. The selected controller project and its documentation are added to the Studio 5000 Architect  project.

• To import or update to a new project file, select Create New.

• To import or update to a project file in the list, select the file, then select Select.

• To import or update to a different project file, select Browse, then add the file to the list. Once Studio 5000 

Architect  verifies the validity of the file, select Select.

Confirm Update Changes
How do I open Confirm Update Changes?

If importing a controller from a file

1. In Hardware Diagram, right-click on a blank area of the hardware diagram, then select Add Controller 

Project.

2. In Open, locate and select the project file to add, then select Open.

3. If importing a 1769 controller, in Bank Configuration, modify the configuration to match the physical 

controller, then select OK.

If importing a controller from an online controller

1. In Hardware Diagram, right-click on a blank area of the hardware diagram, then select Import From Online.

2. In Select Online Controller to Import, browse the network and select the controller to import into your 

project, then click Select.

3. In Choose Matching Controller Configuration File, perform one step:

◦ To create a new project file, select Create New.

◦ To use controller settings from a project file in the list, select the file, then Select.

◦ To use controller settings from a different project file, select Browse, then add the file to the list. Once 

Studio 5000 Architect  verifies the validity of the file, select Select.

4. If importing a 1769 controller, in Bank Configuration, modify the configuration to match the physical 

controller, then select OK.

Confirm Update Changes  lists pending changes to a Studio 5000 Architect  project. This message appears before a 

project import changes a Studio 5000 Architect  project. Review the changes, then continue or cancel the update.
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Add existing FT View project
How do I open Add Existing FactoryTalk View Project?

• In Hardware Diagram, right-click on a blank area of the hardware diagram, then select Add Existing 

FactoryTalk View Project.

Use Add Existing FactoryTalk View Project  to import a FactoryTalk View  application into a Studio 5000 Architect 

project. Studio 5000 Architect  updates the project after import.

When importing a FactoryTalk View ME  application, a PanelView Plus  or MobileView  terminal is added to the hardware 

diagram and its catalog number is set based on the project's station resolution.
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Add networks
Networks in Studio 5000 Architect  represent the hardware and cables that allow components to communicate. After 

connecting components to the same network, create ownership relationships, tags, and I/O aliases.

In ControlNet  and other non-Ethernet networks, must connect components that communicate with each other to the 

same network trunk. ControlNet  and other network trunks are only shown in Hardware Diagram.

In Ethernet networks, connect components that communicate with each other to each other, either directly or 

through Ethernet switches. Ethernet switches display in Hardware Diagram. Managed switches owned by a controller 

also appear in Project Explorer.

Add a managed Ethernet switch
Add a managed Ethernet switch to build or expand an Ethernet network using Stratix  devices. Studio 5000 Architect 

supports managed Stratix  switches ranging from 3 to 20 ports in their default configuration  on page 53. Some 

switches support expansions up to a total of 26 ports.

To add a managed Ethernet Switch

1. In Toolbox, expand Network Infrastructure  and Ethernet Switches.

2. Expand Managed Switches, then expand the list by switch port size.

3. Drag a switch from Toolbox  to Hardware Diagram.

4. (optional) In New Switch Graphic, enter the switch properties:

a. (optional) Name:  Enter a unique name for the switch.

b. (optional) Description:  Enter a description for the switch. Cannot be longer than 128 characters.

c. Address / Host Name:  Set the IP address or host name for the switch.

5. Select OK. The Stratix  switch appears in the Hardware Diagram  and in Project Explorer  under Devices.

Add an unmanaged Ethernet switch
Add an unmanaged Ethernet switch to build or expand an Ethernet network using Stratix  devices. Studio 5000 

Architect  supports unmanaged Stratix  switches ranging from 4 to 8 ports.

To add an unmanaged Ethernet switch

1. In Toolbox, expand Network Infrastructure  and Ethernet Switches.

2. Expand Unmanaged Switches, then expand the list by switch port size.

3. Drag a switch from Toolbox  to Hardware Diagram.

4. In New Switch Graphic, enter a unique name for the switch, then select OK. The switch appears in Hardware 

Diagram  and in Project Explorer  under Devices.

Add a Generic switch
Add a generic switch to the Studio 5000 Architect  project. Use generic switches to connect mainstream Ethernet 

hardware to the automation system.
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To add a Generic Switch

1. In Toolbox, expand Network Infrastructure  and Generic Switch.

2. Drag a Generic Switch  from Toolbox  to Hardware Diagram.

3. (optional) In New Generic Switch Graphic  on page 52, configure the switch properties:

◦ Name:  Enter a unique name for the switch.

◦ Description:  Enter a description for the switch. Cannot be longer than 255 characters.

◦ Type:  Select whether the switch is Managed or Unmanaged.

◦ Number of Ports:  Select the number of ports on the switch.

◦ Address / Host Name:  If the switch is managed, set the IP address or host name for the switch.

4. Select OK. The generic switch appears in Hardware Diagram  and in Project Explorer  under Devices.

Add a network trunk
ControlNet  and other network trunks represent the cabling that connects non-Ethernet components. Using multiple 

controllers or modules to communicate across a ControlNet  or other non-Ethernet network requires a network trunk.

ControlNet  trunks are blue, other network trunks are black.

To add a network trunk

1. From the Network Trunk  list, select a network trunk type, then select Network Trunk Tool.

2. In Hardware Diagram, either:

◦ Select the location to set the trunk position.

◦ Drag over a location to set both the trunk position and size.

Studio 5000 Architect  displays the network trunk in Hardware Diagram.

Connect Ethernet components
For Ethernet components to communicate with each other, connect them to the same Ethernet network. In most 

cases, components connect to an Ethernet switch. Components with multiple Ethernet ports support Device Level 

Ring (DLR) connections and can connect components without a switch.

Ethernet connections and ports are green.

To connect Ethernet components

1. In Hardware Diagram, drag the component or component port to an unused port on an Ethernet switch or 

other Ethernet component.

2. (optional) If the new connection links two previously unconnected networks, Studio 5000 Architect  combines 

them into a single network. In Select Network Name, enter a network name for the combined network, then 

select OK.

Connect components to a trunk
In order for ControlNet  and other non-Ethernet components to communicate with each other, connect the 

components  on page 51 to the same network trunk. Components can only connect to one network trunk at a time.

ControlNet  connections are blue, other network connections are black.
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To connect a device to a network trunk

• In Hardware Diagram, drag the component or component port to the ControlNet  or other network trunk.

Add an Ethernet Tap
Add an Ethernet tap to monitor messages on an Ethernet network.

To add an Ethernet tap

1. In Toolbox, expand Network Infrastructure, Ethernet Switches, Managed Switches, and 3-Port Switches.

2. Drag an Ethernet tap from Toolbox  to Hardware Diagram.

3. In New Switch Graphic, configure the switch properties, then select OK:

◦ (optional) Name:  Enter a unique name for the Ethernet tap.

◦ (optional) Description:  Enter a description for the Ethernet tap.

◦ Address / Host Name:  Select a network type and set the IP address or host name for the Ethernet tap.

4. Select OK. The Ethernet tap appears in Hardware Diagram  and in Project Explorer  under Devices.

New Generic Switch Graphic
How do I open New Generic Switch Graphic?

1. In Toolbox, expand the Network Infrastructure  and Generic Switch  folders.

2. Drag a Generic Switch  from Toolbox  to the Hardware Diagram.

Use New Generic Switch Graphic  to set switch settings for a new Ethernet switch. Edit these settings after the 

switch is added to the project.

Settings Description

Name Specifies the name of the generic switch.

Description Specifies the description of the generic switch. Cannot be 

longer than 255 characters.

Type Specifies the type of switch:

• Unmanaged: Unmanaged switches provide a basic 

network connection. No additional network configuration 

is required with this option.

• Managed: Managed switches allow taking control of 

communication over an Ethernet network. Configure the 

address or host name if choosing this option.

Number of Ports Specifies the number of ports to create connections between 

communication modules. The value range is 2 to 26.
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Settings Description

Address/Host Name Specifies the IP configuration for a managed switch. Three 

options are:

• Private Network: Select the value from the list, from 1 to 

254.

• IP Address: Enter a unique IP address to identify each 

node on the IP network.

• Host Name: Enter a fully qualified domain name, such as 

switch.yourcompany.com.

Switch Configuration
How do I open Switch Configuration?

1. In Toolbox, expand the Network Infrastructure, Ethernet Switches, Managed Switches  or Unmanaged 

Switches, and number of port folders.

2. Drag the desired switch from Toolbox  to the Hardware Diagram.

Use Switch Configuration  to set the name, description, and network settings for a new Stratix  switch or Ethernet tap. 

Edit these settings after the switch or tap is added to the project.

Settings that do not apply to the switch or tap are hidden.

Setting Description

Type Specifies the type of the switch.

Vendor Shows the vendor information of the switch.

Name Shows the switch name specified in New Switch Graphic.

Description Specifies the description for the switch. Cannot be longer than 

128 characters.

Expansions Specifies the port expansion information. Three available 

options are:

• (0) - None

• (1) - 8 port expansion

• (2) - 8 port expansion (16 ports total)

Address / Host Name Specifies the configuration for the switch. The setting is 

available if the switch type is Managed. Three options are:

• Private Network: Select the value from the list, from 1 to 

254.

The Private Network  setting is not available for Stratix 

6000 switches.

• IP Address: Enter a unique IP address to identify each 

node on the IP network.

• Host Name: Enter a fully qualified domain name, such as 

switch.yourcompany.com.
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Add relationships and tags
For components to communicate with each other in production, they must have one of three relationships:

Relationship Description

Ownership relationship Connects one module to one controller or FactoryTalk Linx 

server.

Producer/consumer relationship Connects one controller to another controller.

Shortcut Connects one controller to a FactoryTalk Linx  server for use in a 

FactoryTalk View  application.

Once two components have a relationship, they can communicate with each other using one or more tags. Add tags 

for producer/consumer relationships, point tags, and axis tags using Studio 5000 Architect  or Logix Designer.

Ownership relationships
An ownership relationship connects one module to one controller or FactoryTalk Linx  server. Once the relationship 

is added, the controller or server "owns" the module and can read from or write to its tags. A controller or server can 

own multiple modules. Modules can have multiple owners. In large automation systems, ownership relationships can 

be very complex with many modules owned by many controllers across multiple chassis.

Ethernet devices owned by or added to the I/O configuration of a controller are counted toward the node limits of the 

controller.

Studio 5000 Architect  displays the owned modules for each controller in Project Explorer  under the controller 

project's I/O Configuration  folder. Studio 5000 Architect  displays owned modules for each FactoryTalk Linx  server in 

Communications.

To add an ownership relationship  on page 58, one of these conditions must be true:

• Either the controller and the target module must be on the same chassis

• Or the controller or FactoryTalk Linx  server must own all communication modules along the path to the target 

module's chassis

Example

A controller in Chassis A needs to read tags from an input module across the factory floor in Chassis B. The two 

chassis are physically connected using an Ethernet network. Adding an ownership relationship between the controller 

and the input module is a four step process:

1. In Studio 5000 Architect, connect the two chassis together using communication modules and an Ethernet 

switch.

2. Add an ownership relationship between the communication module in Chassis A and the controller.

3. Add an ownership relationship between the communication module in Chassis B and the controller.

4. Add an ownership relationship between the input module in Chassis B and the controller.
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Project Explorer  on page 9 shows the path of owned modules in the controller project's I/O Configuration  folder.

Producer/Consumer relationships
A producer/consumer relationship connects one controller to another controller. Once the relationship is added, 

the consumer controller can read from or write to specific tags provided by the producer controller. A consumer 

controller can consume tags from many producer controllers. Similarly, a producer controller can produce tags for 

many consumer controllers. In large automation systems, producer/consumer relationships can be very complex with 

many controllers producing and consuming tags from multiple controllers.

Studio 5000 Architect  displays the producer controllers for each consumer controller in Project Explorer  under the 

controller project's I/O Configuration  folder.

To add a producer/consumer relationship  on page 58, one of these conditions must be true:

• Either the consuming controller and the producing controller must be on the same chassis

• Or the consuming controller must own all communication modules along the path to the producer controller's 

chassis

Example
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A controller in Chassis A needs to consume tags from a controller across the factory floor in Chassis B. The two 

chassis are physically connected using an Ethernet network. Adding a producer/consumer relationship between the 

consuming controller and the producing controller is a four step process:

1. In Studio 5000 Architect, connect the two chassis together using communication modules and an Ethernet 

switch.

2. Add an ownership relationship between the communication module in Chassis A and the consuming 

controller in chassis A.

3. Add an ownership relationship between the communication module in Chassis B and the consuming 

controller in chassis A.

4. Add a producer/consumer relationship between the producing module in Chassis B and the consuming 

controller in Chassis A.

Project Explorer  on page 9 shows the path of owned modules and producer controllers in the consumer controller 

project's I/O Configuration  folder.

Shortcuts
A shortcut connects one controller to a FactoryTalk Linx  server for use in a FactoryTalk View  project. Once the 

relationship is added, the FactoryTalk Linx  server can read from or write to the controller's tags. This allows a 

FactoryTalk View  application to communicate with a controller.
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Studio 5000 Architect  displays the shortcuts for each FactoryTalk Linx  server in Communications.

To add a shortcut  on page 59, the FactoryTalk Linx  server must own all communication modules along the path to 

the target module's chassis.

Example

A FactoryTalk View  application with a FactoryTalk Linx  server (right) needs to read tags from a controller across the 

factory floor in Chassis A. The chassis and the computer are physically connected using an Ethernet network. Adding 

a shortcut between the FactoryTalk Linx  server and the controller is a three step process:

1. In Studio 5000 Architect, connect the computer hosting the FactoryTalk Linx  server to Chassis A using 

communication modules and an Ethernet switch.

2. Add an ownership relationship between the communication module in Chassis A and the FactoryTalk Linx 

server.

3. Add a shortcut between the controller in Chassis A and the FactoryTalk Linx  server.
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Communications  on page 66 shows the path of each shortcut from the FactoryTalk Linx  server to the controller.

Add an ownership relation
An ownership relation connects one module to one controller or FactoryTalk Linx  server. Once the relation is added, 

the controller or server owns the module and can read from or write to its tags.

FactoryTalk Linx  servers can only own controllers or communication modules and can only read tags from controllers.

Prerequisites

• Either place the controller and the target module on the same chassis, or make the FactoryTalk Linx  server 

the owner of all communication modules along the path to the target module.

To add an ownership relation

1. In Hardware Diagram, locate the module to be owned by the controller or FactoryTalk Linx  server.

2. Drag the module on top of the controller or FactoryTalk Linx  server.

3. In Configure Module  on page 62, set the keying, and network settings, then select OK.

4. Commit the hardware diagram to save the module configurations to the Logix Designer  project or FactoryTalk 

View  application.

Project Explorer  displays the owned modules for each controller and Communications  displays owned 

modules for each FactoryTalk Linx  server.

Add a Producer/Consumer relation
A producer/consumer relation connects one controller to another controller. Once the relation is added, the consumer 

controller can read from or write to specific tags provided by the producer controller.
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Prerequisites

• Either place the consumer controller and producer controller on the same chassis, or make the consumer 

controller the owner of all communication modules along the path to the producer controller

To add a producer/consumer relation

1. In Hardware Diagram, locate the controller to produce tags for the consumer controller.

2. Drag the producer controller on top of the consumer controller.

3. In Configure Module  on page 62, set the keying settings, then select OK.

4. Commit the hardware diagram to save the controller configurations to the Logix Designer  projects.

Project Explorer  shows the path of owned modules and producer controllers in the I/O Configuration  folder 

of the consumer controller project.

Add a shortcut
A shortcut connects one controller to a FactoryTalk Linx  server for use in a FactoryTalk View  application. Using the 

shortcut, the FactoryTalk Linx  server reads from or writes to the controller's tags. This allows a FactoryTalk View 

application to communicate with a controller.

Prerequisites

• The FactoryTalk Linx  server must own all communication modules along the path to the target controller.

To add a shortcut

1. In Hardware Diagram, locate the controller to use in the FactoryTalk View  application.

2. Drag the controller on top of the computer that hosts the FactoryTalk Linx  server.

3. In Add New or Modify Existing Shortcut, set the shortcut settings, then select OK:

◦ Shortcut name:  Enter a new shortcut name or select an existing shortcut from the list. Selecting an 

existing shortcut overwrites it.

◦ OJine tag file:  Enter a path to an oMine tag file

◦ Enable Alarms and Events:  Enable or disable Alarms and Events support on the shortcut. Only enable 

if alarms and events are defined in the controller and the FactoryTalk View  application responds to 

those alarms or events.

4. Commit the hardware diagram to save the controller configurations to the FactoryTalk View  applications.

Communications  on page 66 shows the path of each shortcut from the FactoryTalk Linx  server to the 

controller.

Add a produced and consumed tag
Add produced and consumed tags to allow a consumer controller to read and write values in a producer controller.

Prerequisites

• Add a producer/consumer relationship between two controllers.

• In the View  menu, verify Produce/Consume Tags  is checked.

Rockwell Automation, Inc. ARCH-GR001M-EN-E - January 2024 59



Chapter 8        Add relationships and tags

To add a produced and consumed tag

1. In Produce/Consume Tags  on page 64, select Add.

2. In Consumer Tag, select a consumer controller and a name for the tag.

3. Select Connection.

4. In Producer Tag, select a producer controller.

5. (optional) In Producer Tag  on page 65, configure the tag options:

◦ External Access:  Select the type of access for external controllers: Read/Write, Read Only, or None.

◦ RPI:  Enter a requested packet interval in milliseconds. The producer controller updates the tag once 

per interval.

◦ Allow Unicast Consumer Connection:  Select whether the tag is broadcast using a one-to-one 

consumer connection.

6. Select OK.

7. In Consumer Tag  on page 64, configure the remaining tag options:

◦ Data Type:  Select a data type for the tags.

◦ External Access:  Select the type of access for external controllers: Read/Write, Read Only, or None.

◦ Array Dimensions:  Select the number of dimensions. Only available for array-like data types.

◦ Use Unicast Connection over EtherNet/IP:  Select whether the tag is consumed using a one-to-one 

consumer connection.

8. Select OK.

9. Commit the hardware diagram to save the tags to the Logix Designer  projects.

Add a point tag
A point tag, also known as an I/O alias, allows referencing the point tag instead of the I/O point in your controller 

programs. This is useful shorthand for controllers with many inputs and outputs.

If the Create alias tags automatically when Point Tag is defined  setting in Studio 5000 Architect  options is 

enabled, adding a point tag automatically adds controller scope alias tags in each owning controller's project. If the 

setting is disabled, corresponding alias tags are not added.

Prerequisites

• Verify the I/O module is owned by at least one controller.

• In the View  menu, verify I/O Aliases  on page 66 is checked.

To add a point tag

1. In Hardware Diagram, select an I/O module.

2. In I/O Aliases, click in the Point Tag  column for an I/O point.

3. Enter a name for the point tag, then select Enter.

4. Commit the hardware diagram to save the tags to the Logix Designer  projects.

Add an axis tag
An axis tag allows a controller project to reference a specific axis of motion on a Kinetix  5500 servo drive. Create the 

tag in either Studio 5000 Architect  or Logix Designer. The tag is committed and updated as part of a Logix Designer 

project.
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To add an axis tag

1. Drag the Kinetix  5500 servo drive on top of a controller to create an ownership relationship.

2. In Kinetix  5500 Servo Drives Configuration, set the keying settings.

3. Select the Associated Axes  tab.

4. In Axis Name, enter the name for the axis tag.

5. (optional) In Motion Group, enter or select a motion group to contain the axis tag.

6. Select OK.

7. Commit the hardware diagram to save the tag to the Logix Designer  project.

Studio 5000 Architect  displays the new axis tag and motion group in Project Explorer  under the controller 

project's Motion Groups  folder.

Edit a produced and consumed tag
Edit a produced and consumed tag to change its name, description, data type, access options, or RPI.

To edit a produced and consumed tag

1. In Produce/Consume Tags  on page 64, locate and select the tag to edit.

2. Select Edit.

3. In Consumer Tag  on page 64, edit the name, description, data type, or access options.

4. (optional) Select Connection  to open Producer Tag  on page 65 to edit the RPI, then select OK.

5. Select OK.

Edit a shortcut
Edit a shortcut to change its name or oMine tag file.

To edit a shortcut

1. In Project Explorer, expand the Projects  folder and hardware diagram containing the FactoryTalk View 

application.

2. Expand the FactoryTalk View  project containing the FactoryTalk Linx  server to modify.

3. Right-click the FactoryTalk Linx  server, then select Properties.

4. In Properties, select Shortcuts.

5. Select the arrows next to the shortcut to edit.

6. Change the name or controller tag file.

7. Select OK.

Common module configuration errors
When adding an ownership relationship between an Add-On Profile (AOP) module and a controller, Studio 5000 

Architect  checks the validity of the relationship against Logix Designer  relationship rules. If the relationship is invalid, 

Studio 5000 Architect  displays an error message.

Common error messages include:

Error Message Resolution

Child module incompatible with parent module. Verify module properties in Logix Designer.
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Error Message Resolution

Network size exceeds the allowable size for a network. Remove EtherNet devices from the network.

Child will not work under the specified parent port. Add the ownership relationship with the controller using a 

compatible port.

Catalog Services could not be found. This could indicate the 

Catalog Services is not installed.

Verify Logix Designer  and Catalog Services are installed 

properly.

The maximum number of Ethernet nodes for this controller type 

has been exceeded.

Remove Ethernet devices from the I/O configuration of the 

controller.

The module does not allow disabled electronic keying when 

safety connections are present.

Enable Electronic Keying  in module properties or remove the 

safety connections.

Module is not initialized. Likely cause is the module identity (CIP 

Key) or the module parent is not set.

Remove Powerflex 523 or 525 AC drive devices from the drive 

configuration of the controller.

Ethernet node limitations
Any Ethernet/IP device that is owned by or added to the I/O configuration of a controller is counted towards the node 

limits of the controller. ControlLogix  and CompactLogix  controllers count all devices connected to local and remote 

Ethernet ports.

The maximum number of connected Ethernet nodes varies by controller. Use the Capacity  tab in the Logix Designer 

to determine limits for a controller.

Examples of devices counted as Ethernet nodes when added to the I/O Configuration tree are:

• Remote communication adapter

• I/O modules connected to the EtherNet/IP network

• Motion devices, such as drives

• Remote controllers

• HMI devices that are included in the I/O Configuration tree, for example, PanelView Plus terminals

• Linking devices, such as the 1788-EN2DNR

• Third-party devices that are directly connected to the EtherNet/IP network

The local Ethernet modules and embedded Ethernet ports are not included in the count.

Configure Module
How do I open Configure Module?

If adding an ownership relationship

1. In Hardware Diagram, locate the module to be owned by the controller or FactoryTalk Linx  server.

2. Drag the module on top of the controller or FactoryTalk Linx  server that will own it.

If adding a producer/consumer relationship

1. In Hardware Diagram, locate the controller that will produce tags for the consumer controller.

2. Drag the producer controller on top of the consumer controller.
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Use Configure Module  to set keying and connection settings for a module or producer controller. Use these settings 

to create an ownership relationship or a producer/consumer relationship. Edit these settings using the Edit Device 

Properties Module Configuration  tab.

Settings that do not apply to a module or controller are hidden.

Setting Description

Type Specifies the type of the module.

Vendor Shows the vendor information of the module.

Parent Shows the name of the parent module. If the module is in the 

local chassis, displays Local.

Name Shows the name of the module.

Description Specifies the description for the module.

Comm Format Specifies the format of the module (input or output).

Slot Shows the slot in the chassis where the module exists.

Electronic Keying Specifies the electronic keying protection mode to prevent a 

module from being inserted in the wrong slot.

• Exact Match.  Requires all attributes of the physical 

module and the module created in the software to match.

• Compatible Module Keying.  Accepts or rejects the 

connection based on firmware compatibility.

• Disable Keying.  Requires no attributes of the physical 

module and the module configured in the software to 

match.

Modifying the Electronic Keying option may cause the 

module connection to break or result in a loss of data, or 

both. If used incorrectly, this option can lead to personal 

injury or death, property damage or economic loss.

Revision Specifies the major (primary) and minor (secondary) firmware 

version of the module.

Node Specifies the node on the module trunk where the module 

exists.

This option is only available for ControlNet  modules that you are 

associating with a controller.

Address / Host Name Specifies the configuration for the switch. These settings are 

available for managed Ethernet switches. There are three 

options:

• Private Network: Select the value from the list, from 1 to 

254.

• IP Address: Enter a unique IP address to identify each 

node on the IP network.

• Host Name: Enter a fully qualified domain name, such as 

switch.yourcompany.com.
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Produce/Consume Tags
How do I open Produce/Consume Tags?

• From the View  menu, select Produce/Consume Tags.

Use Produce/Consume Tags  to add  on page 59, edit  on page 61, and remove produced and consumed tags from 

controller projects.

The columns in Produce/Consume Tags  are:

Column Description

Consumer Controller The name of the consumer controller.

Consumer Tag The name of the consumed tag in the consumer controller 

project.

Data Type The data type of the tag, such as BOOL or DINT.

Producer Controller The name of the producer controller.

Producer Tag The name of the produced tag in the producer controller 

project.

RPI The requested packet interval (RPI) of the tag. The producing 

controller updates the tag once per interval. The default interval 

is 20ms.

Class The class of the tag, either Standard or Safety. Only available for 

safety controllers, such as a 1756-L61S.

Consumer Tag
How do I open Consumer Tag?

• In Produce/Consume Tags, select Add  or Edit.

Use Consumer Tag  to add  on page 59 or edit  on page 61 a consumer tag.

The Consumer Tag  settings are:

Setting Description

Controller The controller that consumes the tag.

Tag Name The tag name used in both the producer and consumer 

controller.

Description The description of the tag. Cannot be longer than 120 

characters.

Data Type The data type of the tag, such as BOOL or DINT.
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Setting Description

For safety class producer/consumer tags, the user defined data 

type must be defined in Logix Designer  and the data type of the 

first element must be CONNECTION STATUS.

Class The class of the tag, either Safety or Standard. Only available for 

safety controllers, such as a 1756-L61S.

External Access The level of access that external applications and devices have 

to the tag.

• Read/Write: External applications and devices can both 

read and change the tag's value.

• Read Only: External applications and devices can only 

read the value of the tag.

• None: External applications and devices cannot read or 

change the tag's value.

Array Dimensions Sets the number of dimensions for the tag. The default is 0

Use Unicast Connection over EtherNet/IP Sets whether or not the tag is consumed using a unicast 

connection. This setting is only available if the connection 

between the producer and the consumer is over EtherNet/IP.

Producer Tag
How do I open Producer Tag?

1. In Produce/Consume Tags, click Add  or Edit.

2. In Consumer Tag, click Connection.

Use Producer Tag  to add  on page 59 or edit  on page 61 a producer tag.

The Producer Tag  settings are:

Setting Description

Controller The controller that produces the tag.

Tag Name The tag name used in both the producer and consumer 

controller.

Description The description of the tag. 120 character maximum.

Class The class of the tag, either Safety or Standard. Only available for 

safety controllers, such as a 1756-L61S.

External Access The level of access that external applications and devices have 

to the tag.

• Read/Write: External applications and devices can both 

read and change the tag's value.

• Read Only: External applications and devices can only 

read the value of the tag.

• None: External applications and devices cannot read or 

change the tag's value.
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Setting Description

RPI The requested packet interval (RPI) of the tag. The producing 

controller updates the tag once per interval. The default interval 

is 20ms.

Allow Unicast Consumer Connections Sets whether or not the tag is provided using a unicast 

connection to the consumer controller. This setting is only 

available if the connection between the producer and the 

consumer is over EtherNet/IP.

I/O Aliases
How do I open I/O Aliases?

• From the View  menu, select I/O Aliases.

Use I/O Aliases  to add  on page 60, edit, and remove point tags. I/O Aliases shows each I/O module owned by a 

selected controller and lists the I/O points, direction, and created point tags of the module. Cannot create or edit tags 

for an I/O module unless the module is owned by at least one controller.

The I/O Aliases columns are:

Column Description

Name The name of the module.

Catalog Number The catalog number of the module.

Description The description of the module.

Point The number of the physical input or output point on the module.

Type/Direction The type of input or output, as defined by the module.

Point Tag The point tag as defined for the module.

InputController Shows the alias tag as defined in each owner controller's 

project. If multiple controllers own the module, multiple columns 

are shown.

Communications
How do I open Communications?

• From the View  menu, select Communications.

Use Communications  to view and edit shortcut paths for FactoryTalk View  applications that have FactoryTalk Linx 

servers.
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Add New or Modify Existing Shortcut
How do I open Add New or Modify Existing Shortcut?

1. In Hardware Diagram, locate the controller to use in the FactoryTalk View  project.

2. Drag the controller on top of the computer that hosts the FactoryTalk Linx  server.

Use Add New or Modify Existing Shortcut  to set a name and oMine tag file for a new or existing shortcut. Change 

these settings after the shortcut is created using the Properties Shortcuts  tab when editing a FactoryTalk Linx 

server.
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Customize a hardware diagram
Add graphics  on page 68, files  on page 68, text boxes  on page 68, shapes  on page 68, and links  on page 69

to display additional information or reference material about the project. Graphics, files, text boxes, shapes and links 

appear in Hardware Diagram.

Add a graphic
Add a graphic in Hardware Diagram  to display information related to the network design. Studio 5000 Architect 

provides a set of sample device images, located at C:\Users\Public\Documents\Studio 5000\Samples\Architect

\Graphics.

To add a graphic

1. Select Edit > Add Graphic.

2. In Add Graphic, type the path to the file or select Browse  to select an image file, then select OK.

Add a file
Add any file to Hardware Diagram  to accompany the project. Add any file type. Commonly added files are 

configuration and documentation. Added files are copied into the project folder and appear in Hardware Diagram  as 

images.

To add a file

1. Select Edit > Add File.

2. In Add File, configure the image and file settings:

◦ Image file name:  Enter the path to the file or select Browse  to select an image file.

◦ File name:  Enter the path to the file or select browse to select the file.

3. Select OK. Studio 5000 Architect  adds the file to the project and the file appears in Hardware Diagram  as the 

selected image.

Add a text box
Add text boxes in Hardware Diagram  to label components.

To add text

1. From the Drawing  toolbar, select the Text Tool.

2. Click in Hardware Diagram  to set the position or select and drag to set both the position and size.

3. In Text Box Properties  on page 69, configure the text settings:

◦ In the space provided, type the text.

◦ (optional) Select the text properties, such as bold, italic, underline, strikeout, color, and font.

◦ (optional) Choose a border for the text box and specify the options for the border style.

4. Select OK. The text appears in Hardware Diagram.

Add a shape
Add shapes in Hardware Diagram  to label and group components.
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To add shapes

1. From the Drawing  toolbar, select the appropriate tool:

◦ Line Tool

◦ Rectangle Tool

◦ Circle Tool

2. Drag in Hardware Diagram  to set the position and size.

Add a link
Add a web link in Hardware Diagram  to refer to a web page or document containing more information about the 

network design. Web links are represented in Hardware Diagram  using text and an optional image.

To add a link

1. Select Edit > Add Web Link.

2. In Add Web Link, configure these settings:

◦ Text:  Enter the text to display in the hardware diagram.

◦ (optional) Image:  Enter the path to the file or select Browse  to select an image file.

◦ URL:  Enter the URL to the content.

3. Select OK. Studio 5000 Architect  displays the link in Hardware Diagram.

Text Box Properties
How do I open Text Box Properties?

• If adding a text box, select the  Text Tool, then click in Hardware Diagram  to set the position  or drag 

across the hardware diagram to set both the position and size.

• If editing a text box, right-click the text box and select Properties.

Use Text Box Properties  to add or edit a text box in a Studio 5000 Architect  project. Change the text, font, size, color, 

effects, and borders of a text box.

Supported graphic formats
Studio 5000 Architect  supports these graphic formats:

• Bitmap (BMP)

• Device-independent bitmap (DIB)

• Graphics interchange format (GIF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphics (PNG)

• Icon (ICO)

Element Properties
How do I open Element Properties?

• In Hardware Diagram, right-click on a rectangle, circle, or line, then select Properties.

Use Element Properties  to set border and fill options for a rectangle, circle, or line.
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Commit and update hardware diagrams
Committing a hardware diagram  on page 70 pushes all changes made to software components in Studio 5000 

Architect  into the associated Logix Designer  and FactoryTalk View  project files. Any differences in the project files, 

including AOIs and UDTs, are overwritten. Studio 5000 Architect  creates a new project file if it does not exist.

Updating a hardware diagram  on page 71 pulls all changes made in associated Logix Designer  or FactoryTalk 

View  project files into Studio 5000 Architect  components. Updating with an online controller applies changes in the 

controller project to Studio 5000 Architect  components. Any differences in the Studio 5000 Architect  components, 

including Add-On Instructions (AOIs) and User Defined Types (UDTs), are overwritten.

To avoid accidentally overwriting project and application changes, commit changes from Studio 5000 Architect 

before editing in Logix Designer  or FactoryTalk View Studio. Similarly, update changes from Logix Designer  or 

FactoryTalk View Studio  before editing in Studio 5000 Architect.

Commit a hardware diagram
Committing a hardware diagram pushes all changes made to software components in Studio 5000 Architect  into 

the associated Logix Designer  and FactoryTalk View  application files. Committing overwrites any differences in the 

project files. Studio 5000 Architect  creates new project files if they do not exist. Commit each hardware diagram 

separately.

To avoid accidentally overwriting project and application changes, commit changes from Studio 5000 Architect 

before editing in Logix Designer  or FactoryTalk View Studio.

IMPORTANT:   If a FactoryTalk View  application has a shortcut that is not in the Studio 5000 Architect 

project, the commit does not remove the shortcut from the FactoryTalk View  application. 

To commit a hardware diagram

1. In Project Explorer, expand the Devices  folder, then select a hardware diagram.

2. From the Sync  menu, select Commit Diagram Changes.

3. In Commit Summary, review the changes to the Logix Designer  or FactoryTalk View  applications, then select 

OK.

4. When Studio 5000 Architect  finishes committing the hardware diagram, in Committing Projects, select 

Close. The results appear in Output  on page 73.
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Update a hardware diagram
Updating a hardware diagram applies all changes made in associated Logix Designer  or FactoryTalk View  application 

files to Studio 5000 Architect  components. Any differences in the Studio 5000 Architect  components are overwritten. 

Update each hardware diagram separately.

If a Logix Designer  project or FactoryTalk View  application contains a module that is not supported, Studio 5000 

Architect  adds an unsupported module image in the appropriate chassis, DIN rail, or slot. If a module is unnamed, 

Studio 5000 Architect  automatically generates a module name based on the catalog number of the module.

To avoid accidentally overwriting project and application changes, update changes from Logix Designer  or 

FactoryTalk View Studio  before editing in Studio 5000 Architect.

To update a hardware diagram

1. In Project Explorer, expand the Devices  folder, then select a hardware diagram.

2. From the Sync  menu, select Update Diagram Changes.

3. (optional) If Ethernet Configuration  appears, configure the Ethernet connections, then select OK.

4. In Update Summary, review the changes to the hardware diagram, then select OK.

5. (optional) If Validate Results for PointTag update  appears, review changes to point tags, then select OK.

The results of the update show in Output  on page 73.

Update a diagram with a controller
Updating with an online controller applies changes from the controller project into Studio 5000 Architect 

components. Any differences in the Studio 5000 Architect  components are overwritten. Update each hardware 

diagram separately.

If the controller project contains a module that is not supported, Studio 5000 Architect  adds an unsupported module 

image in the appropriate chassis, DIN rail, or slot. If a module is unnamed, Studio 5000 Architect  automatically 

generates a module name based on the module's catalog number.

To avoid accidentally overwriting project and application changes, update changes from Logix Designer  or 

FactoryTalk View Studio  before editing in Studio 5000 Architect.

Studio 5000 Architect also supports FactoryTalk Logix Echo, a new type of controller emulator. The following steps 

use physical controller as an example. The steps also apply to emulated controller. Before you import a controller 

project from an online emulator, create an emulated controller in FactoryTalk Logix Echo and download a Logix 

Designer project to the emulated controller.

NOTE:   Studio 5000 Architect supports importing all variants of emulated 1756-L8x ControlLogix and 

GuardLogix controllers. 

To update a hardware diagram with an online controller

1. In Project Explorer, expand the Devices  folder, then select a hardware diagram.

2. From the Sync  menu, select Update Changes from Online Controller.

3. In Select Online Controller to Update  on page 74, browse the network and select the controller to import 

into the hardware diagram.
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4. (optional) To update the online controller to a project other than the one associated with the existing 

controller component, select Use existing Logix project file.

5. Click Select.

6. (optional) If Use existing Logix project file  is selected, Choose Matching Controller Configuration File  on 

page 48 appears. Perform one of these steps:

◦ To update to a new project file, select Create New.

◦ To update to a project file in the list, select the file, then Select.

◦ To update to a different project file, select Browse, then add the file to the list. Once Studio 5000 

Architect  verifies the validity of the file, click Select.

7. (optional) If updating with a 1769 controller, in Bank Configuration, change the configuration to match the 

physical controller, then select OK.

8. In Update Summary, review the changes to the hardware diagram, then select OK.

9. (optional) If Validate Results for PointTag update  appears, review changes to point tags, then select OK.

The results of the update show in Output.

Commit a single project
Commit a single project to apply all changes made in the Studio 5000 Architect  project to the associated Logix 

Designer  project or FactoryTalk View  application file. Any differences in the project file are overwritten. Studio 5000 

Architect  creates a new project file if one does not exist.

To avoid accidentally overwriting project and application changes, commit changes from Studio 5000 Architect 

before editing in Logix Designer  or FactoryTalk View Studio.

IMPORTANT:   If a FactoryTalk View  application has a shortcut that is not in the Studio 5000 Architect 

project, the commit does not remove the shortcut from the FactoryTalk View  application. 

To commit a single project

1. In Project Explorer, expand the Projects folder.

2. (optional) If Arrange Projects by Hardware Diagram  is enabled, expand the hardware diagram containing 

the project.

3. In Project Explorer, select a project.

4. From the Sync  menu, select Commit Project Changes.

5. In Commit Summary, review the changes to the Logix Designer  project or FactoryTalk View  application, then 

select OK.

6. When Studio 5000 Architect  finishes committing the project, in Committing Projects select Close. The 

results display in Output  on page 73.

Update a single project
Update a project to apply all changes made in its associated Logix Designer  project or FactoryTalk View  application 

file to the Studio 5000 Architect  project. Any differences in the Studio 5000 Architect  project are overwritten.

If a Logix Designer  project or FactoryTalk View  application contains a module that is not supported, Studio 5000 

Architect  adds an unsupported module image in the appropriate chassis, DIN rail, or slot. If a module is unnamed, 

Studio 5000 Architect  automatically generates a module name based on the module's catalog number.
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To avoid accidentally overwriting project and application changes, update changes from Logix Designer  or 

FactoryTalk View Studio  before editing in Studio 5000 Architect.

To update a single project

1. In Project Explorer, expand the Projects folder.

2. (optional) If Arrange Projects by Hardware Diagram  is enabled, expand the hardware diagram containing 

the project.

3. In Project Explorer, select a project.

4. From the Sync  menu, select Update Project Changes.

5. (optional) If Ethernet Configuration  appears, configure the Ethernet connections, then select OK.

6. In Update Summary, review the changes to the hardware diagram, then select OK.

7. (optional) If Validate Results for PointTag update  appears, review changes to point tags, then select OK.

The results of the update show in Output  on page 73.

Output
How do I open Output?

• From the View  menu, select Output.

Use Output  to view error, warning, and informational messages about a Studio 5000 Architect  project. By default, 

messages are sorted by time, with the newest message at the bottom of the list. Messages are cleared when the 

project is closed.

Column Description

Severity The type of message, including:

• Error:  An operation was canceled or could not continue. 

Resolve the error condition and repeat the operation to 

continue.

• Warning:  An operation completed, but may have 

significantly changed one or more components in the 

project. Review these components to ensure they function 

as expected.

• Info:  An operation completed successfully.

Time The time the message occurred. Hidden by default.

Hardware Diagram The hardware diagram associated with the message. Hidden by 

default.

Project The Logix Designer  project or FactoryTalk View  application 

associated with the message.
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Column Description

Type The model number of the hardware component associated with 

the message.

Message The message description, explaining the operation status and 

severity.

Select Online Controller to Update
How do I open Select Online Controller to Update?

• In Hardware Diagram, right-click a controller, then select Update With Online.

Select Online Controller to Update  lists controllers connected to the network. Select a controller to update settings 

from the online controller to settings in the Studio 5000 Architect  project. Select Auto Find  to automatically scan the 

network for a matching controller.

Auto Find Matching Controller
How do I open Auto Find Matching Controller?

1. In Hardware Diagram, right-click a controller, then click Update With Online.

2. In Select Online Controller to Update, click Auto Find...

Use Auto Find Matching Controller  when importing or updating a project to scan the network for a matching 

controller.

Choose a configuration file
How do I open Choose Matching Controller Configuration File?

If you are importing a controller from an online controller

1. Select Hardware Diagrams > Import from Online Controller...

2. In Select Online Controller to Import, browse the network, select the controller to import into the project, 

then click Select.

If you are updating a hardware diagram with an online controller

• Select Use external controller configuration file  in Select Online Controller to Update.

Choose Matching Controller Configuration  lists existing project files that are compatible with the controller you are 

importing. The selected controller project and its documentation are added to the Studio 5000 Architect  project.

• To import or update to a new project file, select Create New.

• To import or update to a project file in the list, select the file, then select Select.

• To import or update to a different project file, select Browse, then add the file to the list. Once Studio 5000 

Architect  verifies the validity of the file, select Select.
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Errors during commit and update
Duplication, configuration, permission, communication, and license errors may occur when committing or updating 

a Studio 5000 Architect  project. These errors either cancel the action or continue with limited functionality. They are 

not displayed in Commit Summary  or Update Summary.

Error Message Resolution

Unable to commit a duplicated node <object> with name 

<name>.

Remove the duplicated node from the target project.

HMI <name> is unable to be created for it already exists. Remove the duplicated HMI server from the target project.

Project <name> contains invalid configuration data. Verify the 

project properties, then try again.

Remove the invalid device configuration from the target project.

User does not have permissions <permission> for <scope>. Verify the permissions of the user are set correctly in 

FactoryTalk Security.

User does not have permission to read or list children for 

<scope>.

Verify the permissions of the user are set correctly in 

FactoryTalk Security.

User does not have permission to read/write or list children for 

<scope>.

Verify the permissions of the user are set correctly in 

FactoryTalk Security.

User does not have permission to delete <object>. Verify the permissions of the user are set correctly in 

FactoryTalk Security.

User does not have permission to create <object>. Verify the permissions of the user are set correctly in 

FactoryTalk Security.

User does not have permission to read <object>. Verify the permissions of the user are set correctly in 

FactoryTalk Security.

User does not have permission to write <object>, all children 

under it will not be created.

Verify the permissions of the user are set correctly in 

FactoryTalk Security.

<Scope> scope is in Read-only mode, for the FactoryTalk 

Directory server is not available.

Verify the FactoryTalk Directory  is configured properly. If it is 

remotely hosted, ensure the server is online and can be reached 

on the network.

Component added event could not be fired properly, for it could 

not connect to FactoryTalk Event subsystem.

Verify FactoryTalk View  is installed and configured correctly.

Failed to open HMI <name>. Verify the path to the FactoryTalk View  application is correct 

and the file is not corrupt.

The HMI server is offline. Verify the <HMI> server is online can be reached on the 

network.

Unable to add the display to the application. The application 

already contains the PanelView Plus 7 Standard or Compact 

Machine Edition maximum displays.

Reduce the number of displays in the FactoryTalk View 

application.

Unable to add the display to the application. The application 

already contains the maximum displays the license allowed.

Reduce the number of displays in the FactoryTalk View 

application.

Unable to commit or upload HMI server. The maximum number 

of HMI servers allowed to load on a single computer has been 

reached.

Reduce the number of HMI servers configured to run on the 

computer.
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Error Message Resolution

Unable to set the application to compact version because the 

PanelView Plus 7 Standard or Compact Machine Edition display 

limits have been exceeded.

Reduce the number of displays in the FactoryTalk View 

application.

HMI <name> is not licensed to allow remote connections. Remove remote connections in the FactoryTalk View 

application.

HMI <name> is not licensed and could not be opened. Change the FactoryTalk View  license or remove the HMI server 

from the application.

Unknown error. Controller <name> requires a different Logix 

Designer version 21 to be installed.

This occurs when you attempt to configure, commit, update, or 

open a project in Logix Designer.

Update Logix Designer to at least version 21.03.

Controller project requires RSLogix 5000 version 0 to be 

installed.

This occurs when you attempt to add a controller project.

Update Logix Designer to at least version 21.03.

FT View commit validation rules
Studio 5000 Architect  validates each component of FactoryTalk View  applications before committing to ensure 

compatibility with FactoryTalk View.

Scenario FactoryTalk View  Compatibility Result

Display or global object has a higher 

version than the FactoryTalk View 

application.

Incompatible Commit cancels. Error appears in Commit 

Summary.

Display or global object has a lower 

version than the FactoryTalk View 

application.

Compatible Commit succeeds. FactoryTalk View 

upgrades the display or global object 

when opened in FactoryTalk View Studio.

FactoryTalk View ME  display or global 

object added to FactoryTalk View SE 

application.

Compatible Commit succeeds. FactoryTalk View 

converts the display or global object when 

opened in FactoryTalk View Studio.

FactoryTalk View SE  display or global 

object added to FactoryTalk View ME 

application.

Incompatible Commit cancels. Error appears in Commit 

Summary.

FactoryTalk View ME  macro added to 

FactoryTalk View SE  application.

Incompatible Commit cancels. Error appears in Commit 

Summary.

FactoryTalk View SE  macro added to 

FactoryTalk View ME  application.

Incompatible Commit cancels. Error appears in Commit 

Summary.

Shortcut commit validation rules
Studio 5000 Architect  validates shortcuts before committing to ensure compatibility with the FactoryTalk Linx  server.

Scenario FactoryTalk Linx  Compatibility Result

Shortcut in Studio 5000 Architect  points 

to communication module and controller 

Compatible Commit succeeds.
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Scenario FactoryTalk Linx  Compatibility Result

that match FactoryTalk Linx  server device 

tree.

Shortcut in Studio 5000 Architect  points 

to IP address not used by any device in 

FactoryTalk Linx  server device tree.

Compatible Commit succeeds. Communication 

module and controller added to 

FactoryTalk Linx  server device tree.

Shortcut in Studio 5000 Architect 

points to a controller with a different 

catalog number than the controller in the 

FactoryTalk Linx  server device tree.

Incompatible Commit succeeds. The path is removed 

from the shortcut. Studio 5000 Architect 

displays a warning in Commit Summary.
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Create and use libraries
A library is a list of components from Logix Designer, FactoryTalk View, and other  Rockwell Automation®   products. 

Libraries are independent from Studio 5000 Architect  and configured separately. Use libraries to add components 

to a Studio 5000 Architect  project  on page 80 or export and import libraries to transfer groups of components to 

another computer.

Library components are add-on instruction (AOI), user defined tag (UDT), FactoryTalk View  components, or hardware 

definitions exported from Logix Designer  as .l5x XML files. Libraries have a .lal file extension and are an archive of the 

individual .l5x files, each containing the definitions of each component and any referenced AOIs and UDTs. The .lal file 

name matches the name defined for the library.

This table identifies the types of supported library components:

Logix Designer FactoryTalk View SE FactoryTalk View ME Other

AOI Displays Displays PDF

UDT Global Objects Global Objects

Macros Macros

Images Images

Tag list

Create a new library
Libraries contain the components used in designing an automation system. Create custom libraries for organizing 

groups of components. Libraries are not specific to Studio 5000 Architect  projects.

To create a new library

1. From the Studio 5000 Architect  menu, select Library Management > New Library.

2. In Name, type a unique library name.

3. (optional) In Description, type a phrase to describe the library contents.

4. (optional) In Revision, use the arrows to establish major and minor revisions for the library to support 

manual tracking of libraries over time.

5. (optional) In Revision Note, type a phrase that provides a revision specific description for the library.

6. Select OK  to create new Studio 5000 Architect  Library (.lal) file in the libraries directory (by default C:\Users

\Public\Documents\Studio 5000\Libraries\Architect).

Rename a library
Libraries contain the components used to design an automation system. Components refer to other components by 

component name and type only, not library location. Renaming a library does not require changes to the components 

in that library.

To rename a library

1. In Toolbox  on page 11, right-click a library, then select Rename.

2. Type in a new name for the library, then select Enter.
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Import a library
Libraries contain the components used to design an automation system. Libraries are not specific to Studio 5000 

Architect  projects and can be imported from Logix Designer, FactoryTalk View,  PlantPAx®  , and other Rockwell 

Automation  products.

To import a library

1. From the Studio 5000 Architect  menu select Library Management >  Import Library.

2. In Import Library, navigate to and select one or more library files, then select Open.

The library (or libraries) are automatically shown in Toolbox  on page 11. If a library of the same name already 

exists in Toolbox, Studio 5000 Architect  prompts to select a different library or import the library under a 

new name.

Delete a library
Libraries contain the components used to design an automation system. If a custom library is no longer useful, it can 

be deleted. The Default Hardware Libraries cannot be deleted.

To delete a library

1. In Toolbox  on page 11, right-click a library (or libraries), then select Delete.

2. In Deletion Confirmation in Library Manager  select OK. The library archive file for each selected library, and 

all of its contents, is deleted from the libraries directory.

Export a library
Libraries contain the components used to design an automation system. Libraries are not specific to Studio 5000 

Architect  and can be exported from Studio 5000 Architect  for use in Logix Designer, FactoryTalk View, and other 

Rockwell Automation  software products.

To export a library

1. From the Studio 5000 Architect  menu select Library Management >  Export Library.

2. In Export Library, navigate to and select the location to export the library file.

3. In File Name type the name for the library file.

4. Select Save to export the library.

If a library file of the same name already exists in the directory, Studio 5000 Architect  prompts to replace the 

file.

Export part of a library
Libraries contain the components used to design an automation system. To export a subset of a library, such as a 

single folder of components, create a new library that contains just that subset and then export that library.

To export part of a library

1. From the Studio 5000 Architect  menu select Library Management > New Library.

2. In Name, type a unique library name.

3. (optional) In Description, type a phrase to describe the contents of the library.

4. (optional) In Revision, use the arrows to establish major and minor revisions for the library.
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5. (optional) In Revision Note, type a phrase that provides a revision specific description for the library.

6. Select OK  to create the new Studio 5000 Architect  Library file in the libraries directory (by default C:\Users

\Public\Documents\Studio 5000\Libraries\Architect).

7. In Toolbox  on page 11, right-click a component (or components), then select Copy.

8. In Toolbox, right-click on the target library or folder, then select Paste. Studio 5000 Architect  verifies that 

components with the same name and type do not exist in the target folder or library.

9. Select OK. Studio 5000 Architect  displays the component (or components) in the target library or folder. 

Repeat the copy and paste process as needed to copy the entire subset of components.

10. From the Studio 5000 Architect  menu, select Library Management >  Export Library.

11. In Export Library, navigate to and select the location to export the library file.

12. In File Name, type a unique name for the library file.

13. Select Save to export the library.

Create a new folder
Use folders to organize the components in a custom library. Folder names must not include \ / ? : * " > < or |.

Once created, copy, paste, and move the folders. Components can be imported directly into a folder.

To create a new folder

1. In Toolbox, right-click a custom library, then select New Folder. A folder is added to the tree with the default 

name New Folder_1  selected.

2. Type in a name for the folder, then select Enter.

Rename a folder
Use folders to organize the components in a custom library.

To rename a folder

1. In Toolbox, right-click a folder, then select Rename.

2. Type in a new name for the folder, then select Enter.

Delete a folder
Use folders to organize the components in a custom library. If a folder is no longer useful, it can be deleted.

To delete a folder that contains components, delete each component from the folder first. After all components are 

deleted from the folder, delete the folder from the library.

To delete a folder

1. In Toolbox  on page 11, right-click a folder then select Delete.

2. In Delete Confirmation in Library Manager, select Yes. The folder (or folders) are deleted from the Toolbox.

Add a component to a library
A library component is a Logix Designer  add-on instruction (AOI) or user defined tag (UDT), or a FactoryTalk View 

Studio  display, graphic object, or image. When a component is added to the library, the export file is added to the 

archive file in the libraries directory.
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Components with the same name but different types (for example, AOI or UDT) can exist in the same library or folder 

in the library. Components with the same name and type (for example, AOI) cannot exist in the same library.

Once a component is added to a library, the component can be copied or moved into another library.

To add a component to a library from Logix Designer  or FactoryTalk View Studio

1. Start Logix Designer  or FactoryTalk View Studio  and open a project.

2. In the Controller Organizer, drag the selected component from Logix Designer  or FactoryTalk View Studio  to 

a folder in the Toolbox  in Studio 5000 Architect. Studio 5000 Architect  adds the component to the selected 

library.

To add a component to a library from a project

1. Save the project in Logix Designer.

2. Start Studio 5000 Architect  and open a project.

3. From the main menu, select Library Management  > Add Component to Library.

4. In Add component to Library, click to locate the component, then select OK. Studio 5000 Architect  displays 

the component in the selected library.

Import a component to a library
Import previously exported components from Logix Designer  into a selected library or folder. Multiple components 

can be imported in a single operation.

To import a component from a file

1. In Toolbox  on page 11, right-click the folder or library, then select Import Component.

2. In Import Component, select one or more .l5x files to import, then select Open.

The Toolbox  displays the imported component or components.

Copy components to Logix Designer
Add-on instruction (AOI) and user defined tag (UDT) objects in Studio 5000 Architect  libraries are items that can be 

copied into Logix Designer  projects. Any references within the AOI and UDT objects are automatically copied into the 

Logix Designer  project.

When updating a Logix Designer  project, if a reference in an AOI or UDT is missing from the Logix Designer  project, 

the referenced objects must be copied to the project.

To copy library components from Studio 5000 Architect  to Logix Designer

1. Open Studio 5000 Architect.

2. Open the Logix Designer  project.

3. In Studio 5000 Architect  select View > Toolbox.

4. In Toolbox  on page 11, drag an AOI to the Add-On Instructions  folder or a UDT to the Data Types > User-

Defined  folder in the Logix Designer  Controller Organizer.
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Copy components to FT View Studio
Displays, global objects, and images in Studio 5000 Architect  libraries can be copied into FactoryTalk View SE  or 

FactoryTalk View ME  applications.

To copy library components from Studio 5000 Architect  to FactoryTalk View Studio

1. Open Studio 5000 Architect.

2. Open the FactoryTalk View  application in FactoryTalk View Studio.

3. In Studio 5000 Architect, select View > Toolbox.

4. In Toolbox  on page 11, drag a display, global object, macro, or an image into the FactoryTalk View Studio 

Explorer.

Rename a component
A library component consists of a single Logix Designer  export file. This export file may contain multiple AOIs or UDTs 

- if the export includes all referenced components. When a component is added to the library, the export file is added 

to the archive file in the libraries directory.

Components with the same name but different types (for example, AOI or UDT) can exist in the same library or folder 

in the library. Components with the same name and type (for example, AOI) cannot exist in the same library.

To rename a component

1. In Toolbox  on page 11, right-click a component, then select Rename.

2. Type in a new name for the component, then select Enter.

Delete a component
If no longer useful, delete components added to custom libraries. Deleting a component may break the reference 

relationship with another component in a different folder of the same library.

To delete a component

1. In Toolbox  on page 11, right-click a component (or components), then select Delete.

2. In Delete Confirmation in Library Manager select Yes.

Studio 5000 Architect  reviews all components to determine if they are exclusively referenced by the 

component (or components) being deleted. If referenced exclusively by the component (or components) 

being deleted, Studio 5000 Architect  prompts to delete them as well.

IMPORTANT:   If a library component was placed in a Logix Designer  project and the Studio 

5000 Architect  project was committed, even though the component was deleted from the 

library the component cannot be deleted from the controller project. 

View component properties
Components added to custom libraries have associated properties that provide additional information about the 

component. Properties are read-only.
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To view the properties of a component

• In Toolbox  on page 11, right-click a component, then select Properties.

Replace an AOI in the project
One or more instances of an Add-On Instruction (AOI) in a project can be replaced with an AOI from the library.

To replace an AOI in the current project

1. In Toolbox, right-click an AOI, then select Replace AOI in Project. Studio 5000 Architect  searches the current 

project for all instances of the selected AOI.

During the search operation, the cursor turns into an hourglass-pointer. Upon completion, the results appear 

in the Select one or more AOIs to be replaced  list.

2. Under AOI_Name Details, view relevant details about the currently selected AOI.

3. In Select one or more AOIs to be replaced, review all instances of the selected AOI that are included in 

the current Studio 5000 Architect  project and differ from the AOI in the library. Any differences between the 

currently selected AOI in the library and each instance of that AOI in the current project are highlighted.

4. Confirm all AOIs that are selected for replacement. Make any necessary changes.

5. Select Replace. All selected instances are replaced. A message appears in Results  for each replaced 

instance. The AOI changes are not shown in the controller project until the hardware diagram is committed.

6. Select File > Save.

Show references to AOIs and UDTs
References identify the other instructions that depend on the selected Add-on Instruction (AOI) or user-defined data 

type (UDT).

To show references to AOIs or UDTs

1. In Toolbox, right-click an AOI or UDT component, then select References.

2. Review the references information for the selected component. To query the current library to identify all 

references of the selected AOI or UDT, select Search Library for All References.

3. When complete, select OK.

Toolbox
How do I open Toolbox?

• From the View  menu, select Toolbox.

Use Toolbox  to view default hardware components or add, remove, and manage custom libraries. Drag components 

from the Toolbox  to a Hardware Diagram  to add components to a project.
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Components shown in gray are either unsupported in Studio 5000 Architect  or require a version of Logix Designer 

that is not installed on the system.

The Toolbox  sections are:
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Item Name Description

Filter  on page 87 Enter a catalog number or name to show 

matching Logix Designer, FactoryTalk 

View Studio, and library components.

Product Catalog A list of Logix Designer  and FactoryTalk 

View Studio  components that can be 

added to a hardware diagram.

Libraries A list of libraries containing components 

that can be added to a hardware diagram 

or a Logix Designer  or FactoryTalk View 

Studio  project.

Create New Library
How do I open Create New Library?

• From the Studio 5000 Architect  menu, select Library Management, then select New Library.

Use Create New Library  to set the name, description, and revision information for a custom library. Edit these 

settings from Library Properties.
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Search and print information
Use the search tool to quickly find tags, data types, tasks, programs, instructions, and folders within custom libraries 

and Logix Designer  projects. Print hardware diagrams  on page 86 to a printer to save or reference.

View relationships
Use Show Owner Mode  to view ownership, producer/consumer, and shortcut relationships in a hardware diagram.

To view relationships

1. In Hardware Diagram, right-click anywhere and select Show Owner Mode.

2. In Hardware Diagram, select the controller or server.

The selected controller or server has a light blue highlight. The owned components have darker blue 

highlights.

Print a hardware diagram
Print a hardware diagram to review or archive it outside of Studio 5000 Architect. Large hardware diagrams are 

automatically split across multiple pages. By default, print margins are set at approximately 0.25 inches per side.

To print a hardware diagram

1. In Project Explorer, expand the Project  or Devices  folder, then select the hardware diagram.

2. Select File > Print.

3. In Print, select a printer and print options, then select OK.

Search a project
Search a Studio 5000 Architect  project to find instances of tags, data types, tasks, programs, instructions, and 

folders within custom libraries and Logix Designer  projects.

To search a project

1. From the Edit  menu, select Find.

2. In Find  on page 87, enter search terms, select locations to search, then select Start Search. The results 

display in Find Results.

Print search results
Print search results to review or archive found tags, data types, tasks, programs, instructions, and folders outside of 

Studio 5000 Architect.
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To print search results

1. From the View  menu, select Find Results.

2. In Find Results  on page 87, right-click a row, then select Print Preview  on page 88.

3. (optional) To set print options such as page size and orientation, in Print Preview, select File > Page Setup.

4. In Print Preview, select File > Print. The results are printed using your system default printer.

Filter the Toolbox
Use Filter  to limit which products or library components appear in the Toolbox  on page 11.

To filter the Toolbox

• At the top of Toolbox, select Filter, then enter a filter term.

Matching Logix Designer, FactoryTalk View Studio, and library components appear.

Find
How do I open Find?

• From the Edit  menu, select Find.

Use Find  to search for terms in custom libraries and Logix Designer  projects included in a Studio 5000 Architect 

project. Find  does not search FactoryTalk View  applications.

Setting Description

Find Enter search term.

Match case Determines if the search term is case sensitive.

Whole word Determines if the search must find an exact match, including 

spaces.

Controller Projects Determines the controller projects to search.

Libraries Determines the custom libraries to search.

Look for Determines object types to search.

Close on Search Complete Determines if the Find  closes once the search has completed.

Find Results
How do I open Find Results?

• From the View  menu, select Find Results.

Use Find Results  to view the results of a search. Double-click an item in Find Results  to open the item in Logix 

Designer. By default, items are sorted alphabetically by name. Results are cleared when the project closes.
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Item Description

Name The name of the search result, such as AB:1756_AO6_Struct:C:0.

Kind The kind of the search result, such as DataTypes.

Type The data type of the search result, such as DINT or IO.

Container The component in the project or library that contains the search 

result, such as Controller.

Location The name of the project or library that contains the search 

result, such as Hardware Diagram 01:L75.

Description The description of the search result, if available.

Print Preview
How do I open Print Preview?

• In Project Explorer, expand the Project  or Devices  folder, select the hardware diagram and then select File 

> Print Preview.

- or -

• Perform a search using Find. In Find Results, right-click on a row, then select Print Preview.

Use Print Preview  to review and print search results  on page 86 and hardware diagrams.

Icon Description

Print.  Print the project search results or hardware diagram.

Hand Tool.  Select and scroll through the contents of the search 

results or hardware diagram.

Snapshot Tool.  Select or drag the search results or hardware 

diagram to copy the page or selection to the clipboard.
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Icon Description

Dynamic Zoom Tool.  Drag up to increase the zoom level and 

drag down to decrease the zoom level.

Zoom Out Tool.  Drag a rectangle to decrease the zoom level or 

select to incrementally decrease zoom level.

Zoom In Tool.  Drag a rectangle to increase the zoom level or 

select to incrementally increase zoom level.

Page Width.  Display the search results or hardware diagram, 

including page margins, in the display area.

Margin Width.  Display only the search results or hardware 

diagram that appears within the margins in the display area.

Whole Page.  Display the search results or hardware diagram 

page in the display area.

Zoom Out.  Decrease the zoom level.

Zoom.  Change the zoom level.

Zoom In.  Increase the zoom level.

Continuous.  Successively scroll between multiple pages, 

displaying a continuous flow of project search results or 

hardware diagrams without any page breaks.

Layout.  Configure the display area to show multiple pages 

simultaneously.

Close.  Close Print Preview.

First Page.  Display the first page in Print Preview.

Previous Page.  Display the previous page in Print Preview.

Current Page.  Display the desired page in Print Preview.

Next Page.  Go to the next page in Print Preview.

Last Page.  Go to the last page in Print Preview.

Previous View.  Display the last selected view in Print Preview.

Next View.  Display the next selected view in Print Preview.
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Set Studio 5000 Architect options
Set a variety of options to customize how Studio 5000 Architect  operates. In most cases, changes to the project 

settings take effect immediately. However, if the changed behavior does not occur, close and restart Studio 5000 

Architect.

Specify options settings by configuring the Options  properties tabs.

Project Settings
How do I open Project Settings?

• From the Tools  menu, select Options.

Use Project Settings  to set basic project options.

Option Description

Workspace Directory Specifies the directory used for project backups and projects 

imported from online controllers.

Create project subdirectory under the main project directory By default, creates a subdirectory named for the project under 

the default project directory. Clearing this checkbox stores all 

project files in the default project directory.

Launch new instance of Studio 5000 Architect  if a project is 

already open

Specifies how Studio 5000 Architect  opens projects.

• When selected, Studio 5000 Architect  automatically starts 

a new Studio 5000 Architect  instance when a project is 

open and choosing to open or create a new project.

• When cleared, Studio 5000 Architect  closes the currently 

open project and prompts to save changes before opening 

or creating a new project

Create alias tags automatically when Point Tag is defined Specifies whether alias tags are created automatically when the 

point tag is defined.

When selected, Studio 5000 Architect  automatically unifies alias 

tag names across Studio 5000 Architect, Logix Designer, and 

third party packages (for example, EPLAN  Electric P8).

• When cleared, Studio 5000 Architect  permits unique alias 

tag names across Studio 5000 Architect, Logix Designer, 

and third party software packages.

Update alias tags automatically when Point Tag is updated Specifies whether existing alias tags are replaced upon import.

• When selected, Studio 5000 Architect  automatically 

updates alias tags when importing a file from a third party 

software package (for example, EPLAN  Electric P8).

• When cleared, Studio 5000 Architect  maintains existing 

alias tags when importing an XML file from a third party 

software package.
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Option Description

Arrange projects in the Project Explorer by the hardware 

diagram they support

Specifies whether Project Explorer  sorts projects and 

applications:

• When Arrange Projects by Hardware Diagram is enabled, 

Project Explorer  lists Logix Designer  projects and 

FactoryTalk View  applications by the hardware diagram 

that contains the project or application hardware.

• When Arrange Projects by Hardware Diagram is disabled, 

Project Explorer  lists all Logix Designer  projects and 

FactoryTalk View  applications in a single list.

Restore Defaults Restore to the default settings.

Hardware Diagram options
How do I open Hardware Diagram?

• From the Tools  menu, select Options, then select Hardware Diagram.

Use Hardware Diagram  to set the size, orientation, and language options for hardware diagrams.

Option Description

Size Specifies the desired page size for hardware diagrams.

To ensure that hardware diagrams print correctly, set the 

hardware diagram size to match the page size for the printer.

Orientation Specifies how hardware diagrams display and print, either 

Portrait for a vertical alignment or Landscape for a horizontal 

alignment.

Using Logix Designer Specifies language the Logix Designer  application should use 

when started from within Studio 5000 Architect. This setting 

has no impact on the language display of Studio 5000 Architect.

Show Sheet Boundaries Select to display the boundaries of the printable area in the 

hardware diagram.

User Prompts
How do I open User Prompts?

• From the Tools  menu, select Options, then select User Prompts.

Use User Prompts  to set the options for displaying prompts. Items selected on this tab result in a prompt. Clearing 

the check box stops the prompt from occurring and Studio 5000 Architect  performs the default action.

Option Description

Prompt for configuration changes When attempting to close a project, prompt to save and commit 

to implement the configuration changes.

Prompt for ACD filename change When the .acd file name for a controller changes, prompt to 

commit the hardware diagram.
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Option Description

Prompt for module names When a module is created, prompt with a default module name 

and the opportunity to rename the module.

Prompt for overwrite configuration Before importing or updating with an online controller, prompt 

that the process overwrites the current controller configuration.

Prompt for commit pending changes Before updating with an online controller, prompt to commit any 

pending changes to a hardware diagram.

Prompt for change to recommended Flex terminal base When an alternate Flex wiring base is specified, prompt to 

change back to the recommended Flex wiring base.

Show docking indicators when dragging views When a view is rearranged in the hardware diagram, display 

indicators (top, bottom, left, right, or as a tab of another view 

group) to show where it can dock.

Auto scroll upon selection When a device is selected either in Project Explorer  or 

Hardware Diagram, automatically locate the device in the 

Project Explorer  or Hardware Diagram.

Prompt for confirmation before updating from a project Prompt to confirm changes and update the Studio 5000 

Architect  project prior to updating changes from a controller 

project.

Prompt for confirmation before committing changes to a 

project

Prompt to confirm changes and update the Studio 5000 

Architect  project prior to a commit operation.

Prompt for update when opening a project file Prompt to update changes to the associated .acd file made in 

the Logix Designer  application since the last time the Studio 

5000 Architect  project was open.

Prompt for confirmation when deleting a controller (and 

associated controller project file)

Prompt to delete the controller from the hardware diagram, as 

well as the controller project file (*.acd) associated with that 

controller.

Show duplicate library name dialog box Prompt when specifying a library name that already exists.

Prompt for deletion of referenced component in the Toolbox 

pane

Prompt to delete components exclusively referenced by a 

component currently selected for deletion in Toolbox.

Show duplicate component name dialog box Prompt when specifying a library component name that already 

exists.

Set replace (no backup) as the default when duplicate 

component names are found

Prompt to replace a component (without backing up the original 

with a '_bk' extension) when duplicate component names are 

found (default).

Prompt for Ethernet configuration after updating from a project Prompt to change Ethernet switches and connection settings 

after updating a project.

Libraries
How do I open Libraries?

• From the Tools  menu, select Options, then select Libraries.
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Use Libraries  to set the default location for libraries. If changing the directory location, manually move any existing 

libraries to this new directory location.

Option Description

Default Library Directory The default location is C:\Users\Public\Documents\Studio 

5000\Libraries\Architect. Library paths can include mapped 

network drives and UNC paths. All libraries are stored in the 

same directory.

Libraries are not moved or copied when the directory changes. 

To use existing libraries after the directory changes, copy 

the .lal files to the new directory location.

 Browse button Use to browse a directory structure to provide the path to the 

library directory.
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Set security policies
By default, FactoryTalk Security  single sign-on is enabled. In most cases, FactoryTalk Security  handles log on and log 

off automatically.

If single sign-on is disabled, users must log on and log off of the FactoryTalk Directory  Network and Local Directory 

before using Studio 5000 Architect.

FactoryTalk Security  policies set permissions that determine if a user or group can perform an action in Studio 5000 

Architect  or other FactoryTalk  products. If the user or group does not have the required permissions, Studio 5000 

Architect  actions either displays an error message or has limited functionality.

Single Sign-On
FactoryTalk Security policy setting "Use single sign-on" (SSO) is enabled by default. When enabled, log on once per 

directory, on a given computer using SSO. After logging on, all participating FactoryTalk products that run in that 

directory on that computer automatically use the security credentials of the logged-on user. Work with multiple 

Rockwell Automation  products simultaneously, without having to log on to each software product separately.

When SSO is enabled, no additional operations are necessary unless an alternate FactoryTalk user wants to use 

Studio 5000 Architect. Use Log On to Factory Talk  to log on that user account.

Keep these items in mind concerning how SSO policy settings are used with Studio 5000 Architect:

• The Tools > Security > Log On To FactoryTalk  menu selection is available unless the Studio 5000 Architect 

product policies are installed. Use this men to change the user credentials that Studio 5000 Architect  is 

currently running under, or to change from the SSO user if SSO is enabled.

• If SSO is disabled, Studio 5000 Architect  removes all ties with the computer-wide SSO at startup. When you 

start Studio 5000 Architect  a prompt to log on to FactoryTalk  appears.

• When SSO is enabled, selecting Tools > Security > Log Off does not result in a logged off situation as Studio 

5000 Architect  automatically logs on the SSO user again.

Sign in to FactoryTalk
When single sign on is disabled, logging on to FactoryTalk Security from the Start menu does not automatically log 

into Studio 5000 Architect. Instead, when starting Studio 5000 Architect  you are prompted to log on to FactoryTalk 

before editing a project.

To log on to FactoryTalk

• In Log On to FactoryTalk  on page 100, type the User name  and password, and then select OK.

The Change Password prompt displays if the password to the account is expired or if the administrator 

requires a password change at log on.

Change the logged on user account
If a different user account needs to open or edit a Studio 5000 Architect  project, use Log On to Factory Talk  to 

change to that user account. Change the logon for the network directory, the local directory, or both.
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To change the logged on user account

1. From the Studio 5000 Architect  menu select Tools  > Security  > Log On to FactoryTalk

2. In Log On to FactoryTalk, select Change Logon.

3. Type the User name  and Password, and then select OK.

The Change Password  prompt displays if the account password expired or the administrator requires a 

password change at log on.

Change a password
If the password to an account expired, was compromised, or if the administrator requires a password change at log 

on, change the password from within Studio 5000 Architect. If changing the password of the user account used to log 

on to the computer, it may be necessary to lock the computer and unlock it using the new password to refresh the 

credentials to access network resources.

To change a password

1. From the Studio 5000 Architect  menu select Tools  > Security  > Log On to FactoryTalk.

2. In Log On to FactoryTalk  on page 100, select Change Logon.

3. Select Change Password.

4. In Change Password, in User name, type the domain and alias, for example DOMAIN-NA\alias1.

5. In Old Password, type the current password.

6. In New Password, type the new password. This password must meet any password complexity requirements 

enforced in the organization.

7. In Confirm New Password, retype the new password to confirm and select OK  to apply the change.

Log off
When logging off, choose whether to log off the local user account or the network user account.

If the FactoryTalk Security  policy setting "Use single sign-on (SSO)" is enabled, your local user and network user 

accounts are automatically logged on after attempting to log off Studio 5000 Architect. In this environment, Changing 

the logged on user account permits a different user to work with Studio 5000 Architect.

If SSO is not enabled, log on and log off through the Studio 5000 Architect  Tools menu.

To log off Studio 5000 Architect

• From the Studio 5000 Architect  menu point to Tools  > Security  > Log Off and select the account to log off.

If SSO is enabled, a message appears describing the automatic logon behavior. Confirm the log off.

If SSO is disabled, a log on to FactoryTalk prompt appears.

Set FactoryTalk Directory actions
Use FactoryTalk Directory  permissions to set the actions a user can perform in a Studio 5000 Architect, FactoryTalk 

View, or Logix Designer  project. Unless overridden by individual product policies, these permissions apply to all 

FactoryTalk  products.
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To set FactoryTalk Directory  permissions

1. Open the FactoryTalk Administration Console.

2. In Select FactoryTalk Directory, select Network  or Local, then select OK.

3. In the Explorer  tree, right-click on the top-level node (either Network  or Local), then select Security.

4. In Security Settings, select a user or group from the list.

5. Locate the action, set whether the user is allowed to perform the action, then select OK.

Set Studio 5000 Architect actions
Use Studio 5000 Architect  permissions to set the actions a user can perform in a Studio 5000 Architect  project.

To set Studio 5000 Architect  permissions

1. Open the FactoryTalk Administration Console.

2. In Select FactoryTalk Directory, select Network, then select OK.

3. In the Explorer  tree, expand the System > Policies > Product Policy > Studio 5000 Architect  folders, then 

double-click the Feature Security  policy.

4. In Feature Security Properties, select a policy, then select  to open its security settings.

5. In Configure Securable Action, add or remove users and groups, set whether they are allowed to perform 

the action, then select OK.

6. Select OK.

Set Logix Designer actions
Use Logix Designer  permissions to limit the actions a user or group can perform in a Logix Designer  project. These 

settings also affect what actions Studio 5000 Architect  can perform on Logix Designer  projects, such as adding, 

saving, committing, and updating Logix Designer  projects.

To set Logix Designer  permissions

1. Open the FactoryTalk Administration Console.

2. In Select FactoryTalk Directory, select Network, then select OK.

3. In the Explorer  tree, expand the System > Policies > Product Policies > RSLogix 5000  folders, then double-

click the Feature Security  policy.

4. In Feature Security Properties, select a policy, then select  to open its security settings.

5. In Configure Securable Action, add or remove users and groups, set whether they are allowed to perform 

the action, then select OK.

6. Select OK.

Set FactoryTalk View SE actions
Use FactoryTalk View SE  application or area permissions to limit the actions a user or group can perform in a 

FactoryTalk View SE  application. These settings also affect what actions Studio 5000 Architect  can perform on 

FactoryTalk View SE  applications, such as adding, saving, committing, and updating the application.

To set FactoryTalk View SE  application or area permissions

1. Open the FactoryTalk Administration Console.

2. In Select FactoryTalk Directory, select Network  or Local, then select OK.
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3. In the Explorer  tree, right-click on the FactoryTalk View  application or FactoryTalk View SE  area, then select 

Security.

4. In Security Settings, select a user or group from the list.

5. Locate the action, set whether the user is allowed to perform the action, then select OK.

Set FactoryTalk View ME actions
Use FactoryTalk View ME  permissions to limit the actions a user or group can perform in a FactoryTalk View ME 

application. These permissions are applied on a per-application basis and affect what actions Studio 5000 Architect 

can perform on FactoryTalk View ME  applications, including adding, saving, committing, and updating the application.

To set FactoryTalk View ME  application or area permissions

1. Open the FactoryTalk View ME  application in FactoryTalk View Studio.

2. In the Explorer  tree, right-click on the FactoryTalk View ME  application at the top of the tree, then select 

Security.

3. In Security Settings, select a user or group from the list.

4. Locate the action, set whether the user is allowed to perform the action, then select OK.

Feature Security policies
Studio 5000 Architect  Feature Security policies control user permissions, which determine whether a user or group 

can perform a specific action in Studio 5000 Architect.

Project Policies Description

Create Specifies whether a user is allowed to create a new Studio 5000 

Architect  project.

Open Specifies whether a user is allowed to open an existing Studio 

5000 Architect  project.

Save Specifies whether a user is allowed to save a Studio 5000 

Architect  project.

Studio 5000 Architect permissions
Permissions set in FactoryTalk Security  policies determine if a user or group can perform actions in Studio 5000 

Architect  projects. If the user or group does not have the required permissions, Studio 5000 Architect  actions either 

displays an error message or has limited functionality.

Action Required Studio 5000 Architect  permissions

Create a new Studio 5000 Architect  project Create: Allow

Save: Allow

Open an existing Studio 5000 Architect  project Open: Allow

Save an existing Studio 5000 Architect  project Open: Allow

Save: Allow
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FactoryTalk View SE permissions
FactoryTalk View SE  permissions set in FactoryTalk Security  determine if a user or group can perform actions on 

Studio 5000 Architect  projects that contain FactoryTalk View SE  applications. If the user or group does not have the 

required permissions, Studio 5000 Architect  actions either displays an error message or has limited functionality.

Action
Required FactoryTalk 

Directory  permissions

Required Application 

permissions
Required Area permissions

Add existing FactoryTalk View 

SE  application

List Children: Allow

Read: Allow

List Children: Allow

Read: Allow

List Children: Allow

Read: Allow

Open FactoryTalk View SE 

application in FactoryTalk 

View Studio

List Children: Allow

Read: Allow

List Children: Allow

Read: Allow

List Children: Allow

Read: Allow

Commit new FactoryTalk View 

SE  application

Create Children: Allow

List Children: Allow

Read: Allow

Write: Allow

Not applicable. Not applicable.

Commit existing FactoryTalk 

View SE  application

Create Children: Allow

Delete: Allow

List Children: Allow

Read: Allow

Write: Allow

Create Children: Allow

Delete: Allow

List Children: Allow

Read: Allow

Write: Allow

Create Children: Allow

Delete: Allow

List Children: Allow

Read: Allow

Write: Allow

Update existing FactoryTalk 

View SE  application

List Children: Allow

Read: Allow

List Children: Allow

Read: Allow

List Children: Allow

Read: Allow

Logix Designer settings
Logix Designer  Feature Security policies and permissions set in FactoryTalk Security  determine if a user or group 

can perform actions on Studio 5000 Architect  projects that contain Logix Designer  projects. If the user or group does 

not have the required permissions, Studio 5000 Architect  actions either displays an error message or has limited 

functionality.

Action
Required RSLogix 5000 Feature 

Security policies

Required FactoryTalk Directory  > 

RSLogix 5000 permissions

Add a Logix Designer  project Controller: Secure

Project: New

Project: Open

Import a Logix Designer  project from an 

online controller

Controller: Secure

Project: New (new project file only)

Project: Go Online

Project: Open

Project: Save

Project: Upload

Add a module Controller: Secure Module: Create Properties

Module: Modify Properties

Edit module properties Controller: Secure Module: Modify Properties

Move a module in a hardware diagram Controller: Secure Module: Create

Module: Delete
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Action
Required RSLogix 5000 Feature 

Security policies

Required FactoryTalk Directory  > 

RSLogix 5000 permissions

Module: Modify Properties

Remove a module Controller: Secure Module: Delete

Module: Modify Properties

Open a Logix Designer  project in Logix 

Designer

Controller: Secure Project: Open

Go online with a controller Controller: Secure Project: Go Online

Project: Open

Commit a Logix Designer  project Controller: Secure

Project: New (first commit only)

Controller: Modify Properties

Controller: Unsecure

Module: Modify Properties

Project: Open

Project: Save

Tag: Modify Properties

Update a Logix Designer  project Controller: Secure Project: Open

Update a Logix Designer  project with an 

online controller

Controller Secure:

Project: New (first update only)

Project: Go Online

Project: Open

Project: Save

Project: Upload

Browse tags in the controller Controller: Secure Project: Open

Create aliases for I/O tags Controller: Secure Tag: Modify Properties

Use current tags in a controller to create 

a produce/consume tag relationship

Controller: Secure Tag: Create

Tag: Delete

Add a new tag, and then create a 

produce/consume tag relationship

Controller: Secure Tag: Create

Add a new AOI Controller: Secure Add-On Instruction: Create

Overwrite an AOI that already exists 

(properties are modified)

Controller: Secure Add-On Instruction: Modify

Delete an AOI Controller: Secure Add-On Instruction: Delete

Add a new UDT Controller: Secure User Defined Type: Create

Overwrite an UDT that already exists 

(properties are modified)

Controller: Secure User Defined Type: Modify

Delete an UDT Controller: Secure User Defined Type: Delete

Search a Logix Designer  project Controller: Secure Project: Open

FactoryTalk View ME permissions
FactoryTalk View ME  permissions set in FactoryTalk Security  determine if a user or group can perform actions on 

Studio 5000 Architect  projects that contain FactoryTalk View ME  applications. If the user or group does not have the 

required permissions, Studio 5000 Architect  actions either displays an error message or has limited functionality.
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Action
Required FactoryTalk Directory 

permissions
Required Application permissions

Add existing FactoryTalk View ME 

application

List Children: Allow

Read: Allow

List Children: Allow

Read: Allow

Open FactoryTalk View ME  application in 

FactoryTalk View Studio

List Children: Allow

Read: Allow

List Children: Allow

Read: Allow

Commit existing FactoryTalk View ME 

application

Create Children: Allow

Delete: Allow

List Children: Allow

Read: Allow

Write: Allow

Create Children: Allow

Delete: Allow

List Children: Allow

Read: Allow

Write: Allow

Update existing FactoryTalk View ME 

application

List Children: Allow

Read: Allow

List Children: Allow

Read: Allow

Log on to FactoryTalk
How do I open Log On to FactoryTalk?

• From the Tools  menu, select Security  > Log On to FactoryTalk.

Use Log On to FactoryTalk  to choose the logon credentials used to authenticate Studio 5000 Architect.

• Use a Network  log on to access Network (distributed) applications on the Network Directory Server.

• Use a Local  log on to access Local (stand-alone) applications on the Local Directory.

If you cannot log on to a particular directory on this computer, verify that the user account has permissions 

to that directory.
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Legal Notices
Rockwell Automation  publishes legal notices, such as privacy policies, license agreements, trademark disclosures, 

and other terms and conditions on the Legal Notices  page of the Rockwell Automation  website.

Software and Cloud Services Agreement

Review and accept the Rockwell Automation Software and Cloud Services Agreement here.

Open Source Software Licenses

The software included in this product contains copyrighted software that is licensed under one or more open source 

licenses.

You can view a full list of all open source software used in this product and their corresponding licenses by opening 

the oss_license.txt file in your product's OPENSOURCE folder on your hard drive. This file is divided into these 

sections:

• Components

Includes the name of the open source component, its version number, and the type of license.

• Copyright Text

Includes the name of the open source component, its version number, and the copyright declaration.

• Licenses

Includes the name of the license, the list of open source components citing the license, and the terms of the

license.

The default location of this file is:

C:\Program Files (x86)\Common Files\Rockwell\Help\Architect Release Notes\OPENSOURCE\oss_licenses.txt.

You may obtain Corresponding Source code for open source packages included in this product from their respective 

project web site(s). Alternatively, you may obtain complete Corresponding Source code by contacting Rockwell 

Automation via the Contact  form on the Rockwell Automation website: http://www.rockwellautomation.com/global/

about-us/contact/contact.page. Please include "Open Source" as part of the request text.
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Rockwell Automation Support

Use these resources to access support information.

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification updates. rok.auto/support

Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase

Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature

Product Compatibility and Download Center 

(PCDC)

Get help determining how products interact, check features and capabilities, and find 

associated firmware.

rok.auto/pcdc

Documentation feedback

Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at rok.auto/docfeedback.

Waste Electrical and Electronic Equipment (WEEE)

At the end of life, this equipment should be collected separately from any unsorted municipal waste.

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec.
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